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will be uninterrupted, error-free or virus-free. Purchaser assumes the entire risk of using the software.
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PURCHASER'S EXCLUSIVE REMEDY UNDER THIS WRITTEN WARRANTY OR ANY IMPLIED WARRANTY SHALL BE
LIMITED TO THE REPAIR OR REPLACEMENT, AT MAGELLAN NAVIGATION'S OPTION, OF ANY DEFECTIVE PART OF
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NAVIGATION SERVICE CENTER. ANY REPAIRS BY A SERVICE CENTER NOT AUTHORIZED BY MAGELLAN NAVIGATION WILL VOID THIS WARRANTY.
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To obtain service, contact and return the product with a copy
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Magellan Navigation reserves the right to refuse to provide service free-of-charge if the sales receipt is not provided or if the
information contained in it is incomplete or illegible or if the
serial number is altered or removed. Magellan Navigation will
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careful position charting and use good judgment. READ THE
USER GUIDE CAREFULLY BEFORE USING THE PRODUCT.

The following are excluded from the warranty coverage:

1. MAGELLAN NAVIGATION WARRANTY

(3) finishes;

Magellan Navigation warrants their GPS receivers and hardware accessories to be free of defects in material and workmanship and will conform to our published specifications for
the product for a period of one year from the date of original
purchase or such longer period as required by law. THIS WARRANTY APPLIES ONLY TO THE ORIGINAL PURCHASER OF
THIS PRODUCT.

(4) installations or defects resulting from installation;
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the purchaser for parts or labor. The repaired or replaced product will be warranted for 90 days from the date of return shipment, or for the balance of the original warranty, whichever is
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the correction or replacement of the media or the software so
that it will substantially conform to the then- current user documentation. Magellan Navigation does not warrant the software will meet purchaser's requirements or that its operation

(1) periodic maintenance and repair or replacement of parts
due to normal wear and tear;
(2) batteries;

(5) any damage caused by (i) shipping, misuse, abuse, negligence, tampering, or improper use; (ii) disasters such as fire,
flood, wind, and lightning; (iii) unauthorized attachments or
modification;
(6) service performed or attempted by anyone other than an
authorized Magellan Navigations Service Center;
(7) any product, components or parts not manufactured by
Magellan Navigation,
(8) that the receiver will be free from any claim for infringement of any patent, trademark, copyright or other proprietary
right, including trade secrets
(9) any damage due to accident, resulting from inaccurate satellite transmissions. Inaccurate transmissions can occur due
to changes in the position, health or geometry of a satellite or
modifications to the receiver that may be required due to any
change in the GPS. (Note: Magellan Navigation GPS receivers
use GPS or GPS+GLONASS to obtain position, velocity and
time information. GPS is operated by the U.S. Government
and GLONASS is the Global Navigation Satellite System of the

Russian Federation, which are solely responsible for the accuracy and maintenance of their systems. Certain conditions can
cause inaccuracies which could require modifications to the
receiver. Examples of such conditions include but are not limited to changes in the GPS or GLONASS transmission.).
Opening, dismantling or repairing of this product by anyone
other than an authorized Magellan Navigation Service Center
will void this warranty.
6. EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES
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INCLUDING BUT NOT LIMITED TO LOST PROFITS, DAMAGES RESULTING FROM DELAY OR LOSS OF USE, LOSS OF
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FOR SUCH DAMAGES, EVEN IF MAGELLAN NAVIGATION
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above limitation or exclusion may not apply to you.
7. COMPLETE AGREEMENT
This written warranty is the complete, final and exclusive
agreement between Magellan Navigation and the purchaser
with respect to the quality of performance of the goods and
any and all warranties and representations. THIS WARRANTY
SETS FORTH ALL OF MAGELLAN NAVIGATION'S RESPONSIBILITIES REGARDING THIS PRODUCT.
THIS WARRANTY GIVES YOU SPECIFIC RIGHTS. YOU MAY
HAVE OTHER RIGHTS WHICH VARY FROM LOCALITY TO LOCALITY (including Directive 1999/44/EC in the EC Member
States) AND CERTAIN LIMITATIONS CONTAINED IN THIS
WARRANTY MAY NOT APPLY TO YOU.
8. CHOICE OF LAW.
This limited warranty is governed by the laws of France, without reference to its conflict of law provisions or the U.N. Convention on Contracts for the International Sale of Goods, and
shall benefit Magellan Navigation, its successors and assigns.
THIS WARRANTY DOES NOT AFFECT THE CUSTOMER'S
STATUTORY RIGHTS UNDER APPLICABLE LAWS IN FORCE
IN THEIR LOCALITY, NOR THE CUSTOMER'S RIGHTS
AGAINST THE DEALER ARISING FROM THEIR SALES/PURCHASE CONTRACT (such as the guarantees in France for latent defects in accordance with Article 1641 et seq of the
French Civil Code).
For further information concerning this limited warranty,
please call or write:
Magellan Navigation SA - ZAC La Fleuriaye - BP 433 - 44474
Carquefou Cedex - France.
Phone: +33 (0)2 28 09 38 00, Fax: +33 (0)2 28 09 39 39
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1. Introduction
What is the ProMark3 System?
ProMark3 is a complete GPS system providing precision surveying, GIS feature collection and navigation. A typical
ProMark3 system includes two ProMark3 GPS receivers, GPS
antennas, and all ancillary components required to get you up
and running and producing quality data in a minimum amount
of time.
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Surveying
The ProMark3 system utilizes standard tripods or fixed-height
GPS tripods to position system components above a given survey point. The ProMark3 receiver collects signals broadcast
from GPS satellites, and stores this information in its internal
solid-state memory or an SD Card. The collected data is extracted from the ProMark3 receiver via a cable to an office
computer for post-processing.
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The ProMark3 System operates in conjunction with GNSS Solutions, Magellan Navigation’s highly-automated GPS postprocessing engine.
GNSS Solutions is a complete, easy-to-use software package
which manages and processes raw GPS data, deriving precise
positioning data and presenting the results in easily understood report formats.

Mobile Mapping
The ProMark3 receiver enables you to map and describe GIS
features and then format the data so that later it can be uploaded to a GIS. It offers an easy-to-use and easy-to-deploy solution for general mapping and for asset management.
ProMark3 combines all the navigation capabilities with feature attributing software to support GIS data collection in the
field.
The ProMark3 receiver operates in conjunction with MobileMapper Office. This office software operates as the interface between ProMark3 and your GIS. MobileMapper Office is
also used to refine feature positions for all those field jobs run
in post-processing mode.

Items Supplied with ProMark3
The items supplied with ProMark3 are described in the following paragraphs.
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ProMark3 Receiver
Front Panel
GPS Receiver includes:
• Integrated GPS accurate
to sub-meter with WAAS/
EGNOS
• Ready for RTCM real-time
corrections
• Internal antenna.

Touch screen Display:
• Full color transflective liquid crystal display (LCD)
• ¼ VGA

Scrolling button
Power button
Power indicator

Alphanumeric
keypad

Battery indicator

Back Panel:

Power/Communication
connectors:
• Connects to the I/O
module with power
supply and communication ports

Speaker

Battery door screws:
• Unscrew to open the
battery door

Battery Compartment
Battery Pack
Removable
Handstrap
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Side Panel

External Antenna
Connector

Secure Digital Card Slot
Door:
• Open the door to access the SD card slot

I/O Module
USB host port (Type A), connect to a
USB flash drive, card reader etc.

DC Power Input connector
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Mini USB (Type B) port.
Used for connection to PC

Serial port (COM1) DB-9 connector

USB Cable
The USB cable is used to connect the ProMark3 to an office
computer via the ProMark3’s I/O module. Use the mini USB
port for this connection and not the USB host port.
The mini USB port is located next to the RS232 Sub-D port
on the I/O module. Refer to diagrams on page 4.

AC Adapter/Charger
This device is used to power supply the ProMark3 from the AC
power line.
If an internal battery has been inserted into the ProMark3
unit, this device will also provide a charging current for the
battery. (Battery charging will be monitored by the ProMark3
unit).

External GNSS Antenna
The external GNSS antenna is required for surveying functions. While the built-in antenna is sufficient for navigation, a
more sophisticated external antenna is required to obtain
quality data for precision surveying. The external GNSS antenna is the physical data collection point for the raw GNSS satellite data. For this reason, it must be accurately positioned
over the point to be surveyed, using a standard tripod or fixedheight GPS tripod.

External Antenna Cable
The external antenna cable connects the ProMark3 receiver to
the external antenna. The small end of the cable fitted with a
right-angle plug connects to the ProMark3. The large end of
the cable screws onto the external antenna.
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Vertical Antenna Extension
The vertical antenna extension provides clearance for the antenna cable when the antenna is mounted on a tripod. The
length is 3 inches (0.0762 m).

Field Receiver Bracket
The field receiver bracket provides the means for mounting
the ProMark3 receiver to the tripod.

HI (Height of Instrument) Measurement Tape
The HI measurement tape is used to measure height of the
GPS antenna over the survey point. The end of the tape hooks
onto the antenna. The tape is extended until the spike on the
tape case is on the point. Then the height of the antenna is
noted on the tape.

Field Bag
The field bag is used to transport the components of each
ProMark3 receiver system between the office and the field.

6

User Documentation & MobileMapper Office Software CD
This CD includes the MobileMapper Office software required
to interface ProMark3 with your GIS and post-process your
field data.
This CD also includes the ProMark3 Getting Started Guide
and the ProMark3 Reference Manual.

Initializer Bar and Antenna Adaptor
(Provided with two-receiver systems only.)
The initializer bar can be used to initialize your surveys from
a base. This 0.20-m bar should be mounted on the base tribrach before use. The antenna adaptor will be inserted at the
free end of the initializer bar and will temporarily receive the
rover antenna during the initialization phase.

GNSS Solutions CD
(Provided with two-receiver systems only.)
The GNSS Solutions software provides the tools required to
download and process the GPS satellite data from each
ProMark3 receiver to produce relative positions of all points
surveyed. GNSS Solutions is provided on a CD which also contains a reference manual and tutorial supplement.
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Additional Items Required but not Supplied
For Static Surveys or Base Stations
These items allow you to firmly position the GPS antenna over
the survey point or station site (see opposite) at a measurable
height from the ground.
These items (tripod, tribrach and tribrach adapter) are illustrated below.
Tripod

Tribrach

Levelling bubble

Levelling screw

Tribrach Adapter
mounted to Tribrach:

Optical sight
Locking tab

Tribrach Adapter

Antenna adapter
5/8 x 11 UNC thread

Lock for antenna
adapter
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An option to the tripod, tribrach and tribrach adapter combination is the fixed-height GPS tripod (see below).

For Kinematic Surveys
An option for mounting the ProMark3 rover when operating in
kinematic mode is a range pole (see below).
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Specifications
Parameter
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Specification

GPS survey mode supported

Static, Stop-and-go, Kinematic

Survey accuracy (RMS) Static

Horizontal: 0.005m + 1 ppm
Vertical: 0.010m + 2 ppm

Survey accuracy (RMS) –
Stop-and-go

Horizontal: 0.012m + 2.5 ppm
Vertical: 0.015m + 2.5 ppm

Real-Time Performance

SBAS (WAAS/EGNOS) RMS: Horizontal < 1 meter (3 feet)
DGPS (Beacon or RTCM) RMS: Horizontal < 1 meter (3 feet)

Survey point spacing - Static
(vector length)

Up to 20 kilometers

Survey point spacing – Stopand-go
(vector length)

Up to 10 kilometers

Observation time - Static

4 to 40 minutes typical, depending upon vector length

Observation time – Stop-andgo

15 seconds typical

Initialization time – Stop-andgo

15 seconds on known points
5 minutes on initializer bar

GPS satellite channels

12

SBAS satellite channels

2

GPS satellite elevation mask

10 degrees

Recording interval

1 – 30 seconds

Operating temperature range

-10 to +60 degrees C

Battery type

3.7 V Li-Ion, 3900 mAh

Battery life

8 hours (typical operation)

Data storage memory capacity

128 MB SDRAM, 128 NAND Flash Memory
Removable SD Card: up to 1 GB

Surveying with ProMark3
The ProMark3 system is designed to perform GPS surveys using static, stop-and-go, and kinematic modes of GPS data collection. The three modes run independently.
In the Static data collection mode, the GPS receiver systems
simultaneously collect raw data from all available satellites
while remaining stationary on their respective points. Data
collection continues at these locations for a duration dependent upon the distance between the receivers, the satellite geometry, and the obstruction conditions at the data collection
locations (i.e., trees or buildings blocking some of the sky).
Base

Known Point

Rover

Baseline
(Range)

Survey Point

Data collected at base:
Data collected on surveyed point:
Observation time

When data collection is complete at these specific points, you
move the GPS receiver systems to a new set of points to begin
another data collection session. In most cases, one GPS receiver system will remain on its current point (pivot point) in
order to link the previous set of points to the new set of points,
in leap-frog fashion. After data collection is complete, data is
downloaded form the GPS receivers to an office computer for
post-processing using the GNSS Solutions software.
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The post-processing activity computes vectors (position differences) to determine the position of all observed points relative
to one or more fixed point positions. The static data collection
method produces the most accurate and reliable results of any
mode of GPS data collection. This is due primarily to the extended observation periods required for static data collection.
In the Stop-and-Go data collection mode, the GPS receiver
systems simultaneously collect raw data from all available satellites while stationary on their respective points and while
moving between points. In most cases, one GPS receiver is located on a known point serving as a base station collecting
data at that location for the duration of the survey. Additional
GPS receivers are used to locate objects and move between
points. The occupation period for the stop-and-go method is
much shorter than the static method.
Rover

Base

Known Point

Survey Point
0001

Base

0002

Rover

Init Point

0003
0004

0007

0006

0005

Data collected at base:
Occupation: 15 sec. typical

Data collected by rover:
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Init

0001 0002 0003 0004

0005 0006

0007

After data collection is complete, data is downloaded from the
GPS receivers to an office computer for post-processing using
the GNSS Solutions software. The post-processing activity
computes vectors (position differences) to determine the position of all observed points relative to one or more fixed point
positions. The Stop-and-Go data collection method is faster
than the static method, but not as accurate since the occupation period is much shorter.
In the Kinematic data collection mode, the GPS receiver systems simultaneously collect raw data from all available satellites while a receiver is moving.

Rover

Base

Known Point

Survey Point
0001

Base

Rover

Init Point

0014
0015

Data collected at base:
Data collected by rover:

5 min. with bar

Init

0001...

0015...

In most cases, one GPS receiver is located on a known point
serving as a base station collecting data at that location for the
duration of the survey.
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Additional GPS receivers are used to locate linear objects
such as roads or collect data in a linear fashion for developing
topographic elevation data.
The recording interval should be set to collect the amount of
data needed relative to the speed of travel.
A recording interval too long will result in insufficient data.
After data collection is complete, data is downloaded from the
GPS receivers to an office computer for post-processing using
the GNSS Solutions software. The post-processing activity
computes positions of all observed points relative to one or
more fixed point positions. The Kinematic data collection
method is best used for delineating linear type features such
as roads, fences, lakes, etc.

Mobile Mapping with ProMark3
The ProMark3 system is also designed to log GIS features in
a job file.
GIS features can be of the following types: points, lines, areas
and grids. Grid features are Magellan’s specific features detailed in Logging GIS Data on a Preset Grid Feature on
page 102.
ProMark3 provides in real-time the length of the line you are
logging or the surface area of the area you are logging.
You don’t need an external antenna or any other accessories
to collect GIS jobs. You just need to hold the unit at 45° from
horizontal, not too close to you, and make sure you constantly
have an open view of the sky.
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When you start a new GIS job, ProMark3 asks you to:
1. Choose a feature library for the job.
A feature library lists all the possible feature types you will
see in the field. It also provides all the possible attributes
for each feature type and all the possible values for each
attribute.
After you have chosen a feature library, you will only be
able to log features that comply with those prompted in
this library. You will not be able to add an extra feature
type or an extra attribute to an existing feature. So choosing a library implies that you know the type of job you
want to do.
2. Choose between Real-Time and Post-Processing.
GIS features can be logged in Real-Time or Post-Processing mode.
In Real-Time mode, any logged feature is georeferenced
using the real-time position determined by the ProMark3.
In Post-Processing mode, it is also the real-time position
that is associated with each logged feature but you have
the possibility to improve the accuracy of this real-time
solution through post-processing. This can be achieved
using MobileMapper Office.
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After making these two choices you can start logging your GIS
features in the open job. The navigation screens may be helpful to guide you to the features you have to go to.
When you are next to the feature type you want to log, a point
feature type for example, describing the feature is very quick
and easy as you just have to scroll through the different attributes prompted by the library and set them according to the
information you get from the field (examples: the “color” of
the feature is “black” or the “condition” of the feature is
“needs maintenance”, etc.).
In the background, ProMark3 will add georeferencing information (i.e. one position for a point feature, several positions for
a line or area feature) to the description of the feature.
After data collection is complete, data is downloaded from the
ProMark3 to an office computer using the MobileMapper
Transfer utility of the MobileMapper Office software.
From this software you can export the job to your GIS in a standard GIS format (SHP, MIF, CSV or DXF).
If the job was logged in Post-Processing mode, MobileMapper
Office will allow you to post-process the job. Real-time positions of features will be differentially corrected using raw GPS
data from a nearby reference station.
You can also use MobileMapper Office to upload a previous
job to ProMark3. In this case, the ProMark3 will be used to
update the content of this job. The different features contained in the job will be revisited in the field to update their
attribute values or positions.
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Navigating with ProMark3
The ProMark3 includes a wide range of navigational capabilities that you will find useful in your day-to-day surveying and
mobile mapping operations. Two useful navigation features
are:
• The map screen can be utilized to help you find a project
site.
• The ProMark3 serves as an excellent reconnaissance tool.
You can enter the known coordinates of the feature you
wish to recon as a waypoint, and use ProMark3 to navigate to within 3 meters (10 feet) of the feature in the
field. Be sure to select the correct map datum and coordinate system (use the USER option from the Map Datum
list to define a custom map datum).
More information on SBAS
is available at http://
www.faa.gov/asd/international/sbas.htm
More information on
WAAS is available at the
FAA web site http://
gps.faa.gov/Programs/
WAAS/waas.htm.
More information on
EGNOS is available at
http://www.esa.int/
EGNOS/.

ProMark3 includes the capability to utilize SBAS (SpaceBased Augmentation System).
SBAS includes the Wide Area Augmentation System (WAAS)
for the North American continent and the European Geostationary Navigation Overlay System (EGNOS) to provide improved positioning accuracy.
These systems calculate errors in the GPS signal, then transmit correction messages to capable GPS receivers. Typical accuracy with SBAS is three meters, although this accuracy can
be degraded by multipath reflections and poor satellite geometry.
ProMark3 can also deliver real-time DGPS position fixes for
your navigation using the MobileMapper Beacon from Magellan or any other external corrections receiver.
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Time Spent in The Field
In general, the amount of time required to occupy a point depends on several factors:
1. Distance between survey points. In general, the greater
this distance, the longer the observation time.
2. Environmental conditions, or the amount of obstruction or
canopy preventing a completely open sky view. Some
obstructions may block the reception of the satellite signal, requiring longer observation times to collect additional data for accurate processing.
Too much obstruction prevents ProMark3 (or any GPS
receiver) from receiving enough data to establish quality
survey positions.
3. Satellite Geometry (PDOP): This refers to the position of
the satellites that are orbiting the earth. If the satellites
are positioned poorly (i.e. all on one side of the sky), it is
more difficult to get an accurate position. The Mission
Planning Tool in GNSS Solutions assists in planning survey times with optimal geometry.

Static
You will find that Static observation times will vary between 4
and 40 minutes depending upon factors 1, 2, and 3 above.
The Observation Range feature of ProMark3 is designed to assist in determining observation times.
The Observation Range takes into consideration the number of
satellites and satellite geometry, and determines when enough
data has been collected for a given distance between points.
For more information on the observation range, please refer to
pages 44 and 50.
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Stop-and-Go
Since the Stop-and-Go method requires an initialization, the
occupation times are much shorter than the static method.
Initialization on a known point can be accomplished in as little as 15 seconds with a 1 second recording interval.
Initialization with the initializer bar is typically 5 minutes.
Stop-and-Go point occupations can be accomplished in as little as 15 seconds with a 1 second recording interval.
These occupation times may vary depending upon the three
factors 1, 2 and 3 described above.

Kinematic
The Kinematic method also requires an initialization as detailed in the Stop-and-Go method.
Kinematic data collection does not use an occupation timer
since kinematic data is collected while moving. The recording
interval must be set to a value that properly matches the
speed you are moving.
A recording interval set too slow may result in data that does
not represent the feature being surveyed. A recording interval
set too fast may result in data too dense for a particular application (This is also true in Static and Stop-and-Go).
The base and kinematic units must be set to the same recording interval for successful kinematic survey.

Mobile Mapping
The ProMark3 needs 2 or 3 seconds to open a feature, record
at least one epoch and close the file successfully. So when you
open a point feature, please record for 2 or 3 seconds before
closing the feature. To improve accuracy of point features, we
recommend recording for 30 seconds - or even longer for optimal accuracy.
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For jobs performed in post-processing mode, the time requirements are those defined above for Stop-and-Go and Kinematic
surveys keeping in mind that all GIS/Mapping jobs implicitly
use an OTF initialization.

Where to Find Information
This manual is designed to guide you through the ProMark3
Surveying and Mobile Mapping procedures as well as provide
general reference. You can find additional information in the
following documents:
ProMark3 Getting Started Guide: This manual describes the
basic procedures to start using ProMark3 in surveying and mobile mapping. It also briefly explains how to download your
field data to the office software and how to process this data.
GNSS Solutions Reference Manual: This manual provides detailed instructions for post-processing and presenting the data
collected by ProMark3.
MobileMapper Office User Manual: This manual provides detailed instructions for interfacing the ProMark3 with your GIS.
Magellan Navigation FTP site: Many useful documents relating to the ProMark3 are available at the following FTP site:
ftp://ftp.magellangps.com/Reference Manuals/ProMark3
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2. Preparing For First-Time Use
Charging the ProMark3 Battery Pack
Battery Life
ProMark3 will run for 8
hours with its internal battery in typical conditions
of use.

The ProMark3 includes a rechargeable, replaceable battery
pack. Before using the receiver, you must first charge the battery pack:
1. Locate the removable battery provided.
2. Open the battery door, located in the back of the receiver
using a screwdriver or a coin.
3. Insert the battery –label side upward, contacts towards the
top of the unit– into the battery compartment:

4. Close the battery door and tighten the screws.
5. Attach the Clip-on I/O module to the receiver as shown
below (Insert bottom first, hold down release button, press
I/O module against unit and release button):

6. Connect the AC adapter (see below) and then let it charge
the battery for approximately six hours.

Connect cable from AC
adapter to this input

21

7. To detach the clip-on I/O module, press the release button
on the module.

Control Buttons
Scrolling button

Power button (red)
Alphanumeric keypad

Under the screen you will see eight buttons located around a
large oval “scrolling” button with 4 directional arrows on it.
IN/OUT: Use these buttons to zoom in and out when viewing
a screen with a map displayed.
ESC: Takes you back to the previous screen without effecting
any changes or scrolls navigation screens in reverse order.
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NAV: Takes you to the various navigation screens where you
can locate yourself and navigate to waypoints and features.
LOG: With no job started yet, gives access to the Survey
screen or lets you create or open a GIS job. With an already
started job and with a navigation screen displayed, takes you
back to the Survey or GIS screen last displayed.
ENTER: Use this button to accept highlighted input and to
initiate various functions.
MENU: Valid only after you have entered the Survey or GIS
function. Provides access to a variety of functions such as
setting up the receiver or selecting targets to navigate to various locations.
red power button: Turns on and off the unit.
Scrolling button: This four-arrow button has several functions:
- It is used to move the cursor in the chosen direction,
from a data field to another, from an option in a menu
to the previous or next option.
- In a highlighted field, the left/right arrow moves the
cursor backward/forward; The up/down arrow increments/decrements the highlighted figure or string.
- On the Map screen, a navigation screen, this button
allows you to switch to cursor mode and then to move
the cursor in the chosen direction.
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Alphanumeric keypad: ProMark3 uses a telephone-style alphanumeric keypad.
Buttons 2-9 contain alphanumeric characters. By pressing
the key repeatedly, all characters on that key will be scrolled.
For example, the letters a, b, and c are associated with the
“2” key. Tapping the key once enters an “a,” twice enters a
“b,” three times enters a “c” and four times enters a “2.”
Note that the “0” key includes the backspace. So if you have
to enter “00”, wait about 1 second before entering the second “0” or else you might delete the first “0”.To adjust the
repeat delay and rate, see Keyboard on page 179.
On-screen “virtual” keypad: This keypad is displayed at the
bottom of the screen whenever data entry is requested. This
means you can use this keypad rather than the unit keypad
if you wish.

The on-screen keyboard is fitted with special keys such as
the Shift and CAP keys to switch between upper and lowercase, the backspace key to delete the last entered character,
a space key, etc.
Using this keypad to enter alphabetical characters is more
straigtforward as you just need to tap the corresponding key
on the touch screen.
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Turning On/Off the Receiver

ProMark3 start-up screen

Once you have charged the battery, hold
down the red key (the power button) on
the front of the receiver until the power
indicator turns solid green. You will first
see the receiver’s start-up screen (see
opposite left). Wait for the progress bar
to complete its sequence. The screen
then displays the ProMark3 workspace
with its 4 main icons: Surveying, Mobile
Mapping, Settings and Utilities (see opposite right).
ProMark3 Workspace
When you need to turn off ProMark3,
simply press the
red key until the
screen displays the Shut Down window and then tap OK.

Calibrating the Screen
For the first-time use, you need to align your display screen so
the cursor on the touch screen align with the tip of your stylus.
Use the stylus pen to tap the center of each target that appears on the Calibration screen with the tip of the stylus. Tap
anywhere on the display when finished.
To re-calibrate your screen at anytime, double-tap the Settings
icon then double-tap Stylus from the list, tap the Calibration
tab and then follow the instructions.
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Automatic System Time Update
ProMark3 will automatically update the system date & time
using the GPS time determined by the integrated GPS receiver
and the time zone that you specify. To set the time zone:
• In the ProMark3 workspace, double-tap the Settings icon.
• Double-tap the Date/Time function. This opens the Date/
Time Properties screen.
• Set the time zone field (see opposite) and then select OK
on top of the screen.
Please note that you should wait for a few seconds, after
turning on ProMark3, before system time can effectively
be updated.

Adjusting the Backlight
To switch the backlight on/off for both the keypad and display,
or to adjust the brightness and screen contrast, double-tap the
Settings icon on the ProMark3 workspace and then double-tap
the Backlight Control function.
To conserve battery power, we recommend you to switch the
backlight off whenever possible.
For other settings, please refer to Setup Menu on page 149.

26

Initializing GPS

Please Go Outside to Perform Initialization!
Initialization is required
when 1) the receiver is
brand new, 2) you have
moved more than 500
miles from the last place
you were using it, 3) memory has been completely
erased or 4) the receiver
has not been used for more
than a few months.

Take the receiver to a location where there is a clear view of
the sky, then:
- From the ProMark3 workspace, double-tap successively
the Utilities icon and then the GPS Init icon.
- Scroll down the list of continents and double-tap the continent where you are located (see figure below, left.) Similarly double-tap the country where you are located. Finally
indicate the current time and date (see figure below,
right.) and click OK.

The very first initialization of a GPS receiver may take a few
minutes.
Initialization can be faster if you know the approximate coordinates of your current location. Rather than select your continent on the figure above left, just tap the Enter Coordinates
button on this screen, then enter the approximate coordinates
of your location plus the date and time and then tap OK. This
will speed up the initialization phase.
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DGPS Real-Time Configuration
The ProMark3 GPS receiver integrates SBAS signal reception.
You can also use corrections from an external correction
source, such as MobileMapper Beacon, a belt-mounted, Bluetooth-enabled beacon receiver connected to serial port COM1
or via a Bluetooth port, or from any other RTCM source.
For more information on using ProMark3 with an external corrections receiver, refer to Using MobileMapper Beacon on
page 184 or Using Another RTCM Source on page 190.
To open the DGPS Configuration window (see opposite), double-tap the Utilities icon on the ProMark3 workspace and then
double-tap the DGPS Configuration icon.
If you want a differentially-corrected real-time position, make
the appropriate setting.

Selecting the Surveying or Mobile Mapping
function
From the ProMark3 workspace, do the following:
• Double-tap the Surveying icon if you want to perform a
Static, Kinematic or Stop & Go survey
• Or double-tap the Mobile Mapping icon if you want to perform a GIS/Mapping job.
Whatever your choice, ProMark3 will then display a navigation
screen.
Just press the NAV or ESC button to scroll through the different available navigation screens.
For more information on Navigation screens, please refer to
Navigation on page 126.
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Preliminary Settings
Now that ProMark3 displays a navigation screen, press MENU
and double-tap Setup.
There are many options to select among, and all are explained
in full in Setup Menu on page 149. For the purposes of getting started, however, we will concentrate on just a few of
these options.
As a general rule, tap an option to open the corresponding setting window. Then tap the desired value. This will enable the
value and take you back to the Setup menu. You can also return to the Setup menu by pressing the ESC button.
Notice: These settings can be performed from within either
the Surveying or MobileMapping function.

Storage
ProMark3 can store your jobs either in its internal memory or
on the SD card you have inserted in the unit. Tap the desired
option.

Receiver ID
(From within Surveying function only)
The Receiver ID screen provides you with the ability to enter
the 4-character receiver ID which is used in naming the raw
data files. Each raw data file from this receiver will include
this 4-character receiver ID. It is important that each of your
receivers use a unique Receiver ID.
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Units
You select this option to set the units of measurement you
want to use. Units are presented in this order: long distances,
short distances, speed and area. You can set these units to
“kilometers, meters, kph and hectares” or “miles, feet, mph,
acres” if you like, or to three other standard sets of units. You
can also create a custom mix of units by selecting the Advanced option that contains a wide variety of units for distance, speed, elevation, bearing and area

Checking that ProMark3 is Ready For Field
Operations
Press NAV repeatedly until the Satellite Status screen is displayed. This screen shows which satellites the receiver is
tracking and where they are located in the sky. If you are not
tracking 3 or more satellites you may have to move to a more
open area.
When used with its internal antenna, the receiver will have the
best view of the sky when you hold it at an angle of 45 degrees
and not too close to you.

Satellite Status screen

45°

This allows the internal antenna to function optimally for the
best accuracy.
In Survey jobs for which the external antenna is used, only the
vertical orientation of this antenna is important.
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3. Surveying
This chapter presents step-by-step procedures for performing
a GPS survey with the ProMark3 system. Review this chapter
thoroughly before attempting to perform your first survey. As
an exercise, take your system outside of your office and perform a sample survey following the procedures outlined below.
Then download and process the collected data with GNSS Solutions. After this exercise, you will be ready to perform your
first real survey with the ProMark3 system.

Introduction to Static Surveying
Prior to venturing out into the field, you must first plan how
you will execute your static survey. Proper planning will greatly
increase the chances of success. There are two primary areas
of static survey planning, the network design and observation
plan. Each is discussed below.

Network Design
You have identified a survey for which you wish to use the
ProMark3 system to establish control. Regardless if the number of control points to be established is 2 or 20, you must
design a network defining the number and location of observations (vectors in our case) that will be required to effectively
position the new points.
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As an illustration, consider an example where two new intervisible points are to be established on a project site for use as
control for a boundary survey. The two new points need to be
tied to an existing control point 3 kilometers (1.9 miles) away.

Three-Point Control Survey
Example

If you were to perform this survey with a conventional total station, you would probably plan on running a closed-loop
traverse from the existing control point through the two new
points (see figure below). The same philosophy can be used
for GPS surveys. The figure below is your network design for
this survey

Closed-Loop Traverse
Design
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The previous example resulted in a very simple network design. The figure below represents a more complex control survey where 10 new points are to be established based on 2
existing horizontal and 3 existing vertical control points.

15-Point Control Survey
Example

Again, if you were to perform this survey with a conventional
total station, you would design a traverse plan which produced
a strong looking network of closed-loop traverses through the
points of the survey. The figure below shows one possible network design.

Network Design for 15Point Control Survey

Although this network design was produced with conventional
traversing in mind, this same design can also be used if performing the survey with GPS equipment.
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When designing your network, keep the following principles in
mind:
• Design loops through the network points which resemble a
square or circle. Avoid loops that are long and skinny. Circular or square shaped loops are stronger geometrically.
• Keep the number of points in each loop fewer than 10.
• Always include a direct link between intervisible points,
i.e. points which may be used as a pair for orientation of a
conventional traverse. Since, in most instances, intervisible points are relatively close to each other, it is important
to get a direct observation between them.

Observation Plan
With the network design completed, the next step is to determine how and when data collection will be performed to produce the desired network. First let’s discuss the how.
If you were to use a conventional total station to perform our
three-point survey example, your resulting traverse could
probably look something like this:

Closed-Loop Traverse of 3Point Control Survey

The number of traverse legs required to traverse between each
point in the network will depend upon the conditions on the
ground between the points.
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If you are in luck, the area is relatively flat and there is a
straight road running from the existing control point to the two
new points to be established, thus minimizing the number of
legs required to complete the loop.
Surveying with GPS has the advantage of not requiring line-ofsight between the points surveyed. This allows for direct observations between the points. To illustrate this, let’s take our
3-point control survey network design, shown again below.

2
Network Design for 3-Point
Control Survey

3

1
Assume that a 2-receiver ProMark3 system will be used to perform the above survey. To produce the link between the existing control point 1 and the new point 2, simply place one
ProMark3 receiver system on point 1, place the other receiver
on point 2 and simultaneously collect data between the two
points. When the observation is complete, move the ProMark3
receiver from point 2 to point 3. Perform another observation,
simultaneously collecting data on points 1 and 3. When completed, move the ProMark3 receiver from point 1 to point 2.
Perform the final observation between points 3 and 2. When
this data is downloaded and processed, the result will be three
vectors (delta positions) forming the network design seen in
the above figure.
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Now consider the situation where a 3-receiver ProMark3 system is used. By placing one receiver on each of the 3 points
in our network, the data for all three vectors can be collected
in one observation, rather than the 3 separate observations required with using a 2-receiver system.
Now consider the observation plan for the more complex 15point survey, shown again below.
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5
Network Design for 15Point Control Survey
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To execute this network design, you must perform a direct
GPS observation between all points directly linked. Each link
can be viewed as a required GPS vector. Counting the links in
this network design, you will find that 19 GPS vectors are required to execute this design.
If the survey was to be performed using a 2-receiver ProMark3
system, 19 separate data collection sessions (observations)
would be required. For example, you can start with a receiver
on point 1 and another on point 2. After this observation, you
would move the receiver from point 1 to point 3 to perform an
observation between points 2 and 3, and so on until all vectors
were observed.

36

Now consider the situation where the 15-point control survey
above is to be performed using a 3-receiver ProMark3 system.
With 3 receivers, each observation session will produce 2 vectors from the network design. For example, you may start by
placing one receiver on point 1, the second on point 2, and
the third on point 7. These three receivers would simultaneously collect data on these three points, resulting in the
vectors between points 1 and 2, and points 1 and 7. In addition to these two vectors, a third vector is produced between
points 2 and 7. At the end of this first observation, you could
move the receiver from point 2 to point 9 and the receiver
from point 1 to point 8.
The receiver at point 7 would remain as the pivot point, connecting the first observation to the second. This would continue until all vectors were observed.
The figure below shows what the observation plan might look
like with a 3-receiver ProMark3 system.
6
5

7

4

Receiver Observation Plan
for 15-Point Control Survey

9

8
3

1

2

10

The observation plan shows that it will take 10 separate observation sessions to complete the survey based on the network design shown on page 36.
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Notice that all observation sessions, except for session 6, produce 2 vectors required from the network design. Observation
6 produces only one since there were an odd number of required vectors (19).
This completes the discussion on how to execute the observation plan.
The next question to answer is “When do we perform the observations?”
The best time to perform GPS surveys is determined by an examination of the GPS satellite constellation at your location
for a given time of day. The number of visible GPS satellites
and the distribution of the satellites in the sky are important
factors impacting the observation time required to produce
quality GPS vectors.
Times when the number of visible GPS satellites is low or the
satellite distribution is poor will require extended data collection periods to ensure quality results. In rare instances, availability and distribution may be so poor that you are better off
not performing your survey during these periods.
Included in the GNSS Solutions processing software package
is a module called Mission Planning. The Mission Planning
software provides you with the tools to examine the GPS satellite constellation. Using satellite almanac information,
which predicts the location of the GPS satellites into the future, you can examine satellite availability and distribution for
the day(s) when you wish to perform your survey to isolate any
time periods were observation times may need to be extended
or periods where it is best not to collect data.
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You provide the software with your current location and the
date when you wish to perform your survey. The software then
provides you with multiple ways of examining the satellite
constellation at your location for the given time. Pay particular
attention to satellite availability (number of satellites in view)
and the satellite distribution.
To assist in analyzing the quality of satellite distribution, Dilution of Precision (DOP) values are presented. DOP is a quality analysis value for satellite distribution. The most popular
DOP value is PDOP, which stands for Positional Dilution of
Precision. The PDOP value estimates the impact on the precision of your GPS observations due to satellite geometry. The
smaller the PDOP value the better the satellite distribution
(geometry) and therefore the better the precision of your observations.
With the current constellation of 26+ GPS satellites, it is uncommon to find periods in the day when satellite availability
and distribution are so poor that data collection should be
avoided. Time of poor availability and distribution are usually
short in duration.
When using the static mode of GPS data collection, where observation times are usually 20+ minutes, short periods of poor
availability and distribution can be tolerated.
When performing an observation during which a period of poor
availability and distribution appears, observation times will
normally need to be extended to compensate for this event.
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The ProMark3 receiver includes a feature which estimates the
observation time required to produce a quality solution. This
feature is called the “Observation Range” and is discussed in
more detail later on in this chapter. The Observation Range (or
Observation Timer) takes into account satellite availability and
distribution when determining the required observation time.
If you are collecting data during a period of poor availability
and distribution, you will find the Observation Timer will take
longer to inform you when your survey is completed. It is automatically extending the observation period to compensate
for the poor availability and distribution of satellites.
Analysis of the satellite constellation with Mission Planning
prior to data collection will give you an idea of the time periods
when extended observations will be required
NOTE: The ProMark3 receiver is designed to store GPS data
for only those satellites that are at least 10° above the horizon.
The receiver may lock onto a satellite between 0° and 10° but
will not record this data. When using the Mission Planning
software to analyze the satellite constellation, be sure to set
the satellite cut-off angle to 10°. This will ensure that the satellite availability and distribution presented by Mission Planning matches what is being used by the ProMark3 receiver for
data storage.
NOTE: The ProMark3 will track up to 12 satellites simultaneously. If more than 12 are available, ProMark3 will track the
12 satellites with the highest elevation.
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Running a Static Survey
The procedures for performing a static survey with the
ProMark3 system can be broken down into five primary categories: equipment check, site selection, system setup, static
survey setup and data collection. Following the steps presented below should result in successful execution of your GPS
survey.
Note: Remember that data must be simultaneously collected
between 2 or more ProMark3 receiver systems in order to produce vectors between the receivers. Therefore, the following
procedures must be followed for each ProMark3 receiver system used in the survey. There is no problem in setting up one
ProMark3 receiver system and then moving to another site to
set up another. Just be aware that the observation time is determined by the last receiver set up. For example, if you were
alone and wanted to perform a survey with a 2-receiver
ProMark3 system, you could set up the first receiver and start
data collection. You could then move to the next site and set
up the second receiver. Only when the second receiver is collecting data does simultaneous data collection begin. All the
data collected by the first receiver up to this time is of no use
and will be ignored during data processing.
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Equipment Check
Prior to leaving the office to perform your survey, be sure to
perform a thorough check of your GPS equipment:
1. Check through the ProMark3 system to ensure all components are present to successfully perform the survey.
2. Check to ensure that you have sufficient battery power to
complete the survey. Bring along a spare set of batteries
for insurance.
3. Bring along a copy of your network design and printout of
the satellite availability and distribution analysis. These
will be needed throughout the course of your survey.
With the equipment check completed, it’s time to move to the
field to perform your survey.

Site Selection
Proper site selection of performing GPS data collection is critical to the success of your survey. Not all sites are appropriate
for GPS data collection.
GPS depends on reception of radio signals transmitted by satellites approximately 21,000 km from Earth. Being of relatively high frequency and low power, these signals are not very
effective at penetrating through objects that may obstruct the
line-of-sight between the satellites and the GPS receiver.
Virtually any object that lies in the path between the GPS receiver and the satellites will be detrimental to the operation of
the system. Some objects, such as buildings, will completely
block out the satellite signals. Therefore, GPS can not be used
indoors.
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For the same reason, GPS cannot be used in tunnels or under
water. Other objects such as trees will partially obstruct or reflect/refract the signal; reception of GPS signals is thus very
difficult in a heavily forested area.
In some cases, enough signal can be observed to compute a
rough position. But in virtually every case, the signal is not
clean enough to produce centimeter-level positions. Therefore, GPS is not effective in the forest.
This is not to say that your ProMark3 surveying system can
only be used in areas with wide-open view of the sky. GPS can
be used effectively and accurately in partially obstructed areas. The trick is to be able to observe, at any given time,
enough satellites to accurately and reliably compute a position.
At any given time and location, 7-10 GPS satellites may be
visible and available for use. The GPS system does not require
this many satellites to function. Accurate and reliable positions can be determined with 5 satellites properly distributed
throughout the sky. Therefore, an obstructed location can be
surveyed if at least 5 satellites can be observed. This makes
GPS use possible along a tree line or against the face of a
building but only if that location leaves enough of the sky open
to allow the system to observe at least 5 satellites.
For the above reasons, make every effort to locate new points
to be established in areas where obstructions are at a minimum. Unfortunately, the site location is not always flexible.
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You may need to determine the position of an existing point
where, obviously, the location is not debatable. In situations
were an existing point is in a heavily obstructed area, you may
be forced to establish a new point offset from the existing
point, or preferably a pair of intervisible points, and conventionally traverse to the required point to establish its position.
Be aware that obstructions at a GPS data collection site will
affect the observation time required to accurately determine
its location. Obstructed areas will require longer observation
times.
The Observation Range function of the ProMark3 will automatically extend observation times at obstruction sites but in
some cases, it may not extend the observation period long
enough. You will have to use your own judgement of observation times when surveying obstructed site. Your judgement
will improve through experience.
For large surveys utilizing 3 or more ProMark3 receiver systems, you may want to reckon all the site locations as part of
your survey planning. This will eliminate any delays during the
actual execution of the survey if problems are encountered
finding an appropriate site.
The more receiver systems utilized during the survey, the
harder the task of coordinating the data collection becomes.
Remember, data must be collected simultaneously between
points where a vector is desired. If one receiver operator is late
in starting data collection due to problems with site location,
this could cause problems.
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System Setup (Base and Rover)
Now that the survey site is identified, it is time to set up the
ProMark3 receiver system over the point to be surveyed. The
setup procedure is illustrated below.
2.

7.

4.
6.

3.
5.

H Vertical

H Slant

1.

Typical setup with tripod is
described here. You can
also use a fixed-height
tripod.

1. Set up the tripod / tribrach combination over the survey
point.
This is done in precisely the same manner as for a conventional total station. If using a fixed-height GPS tripod
rather than a conventional tripod, a tribrach is not
required.
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2. Attach the vertical extension bar and a tribrach adapter to
the GPS antenna.
With the GPS antenna in hand, attach the included vertical extension bar to the 5/8-11 thread on the bottom of
the antenna. Attach a tribrach adapter to the other end of
the vertical extension bar. If using a fixed-height GPS tripod rather than a conventional tripod, a tribrach adapter is
not required
3. Place the GPS antenna assembly on the tripod.
Be careful not to disturb the tripod when mounting the
antenna assembly.
4. Place the ProMark3 receiver into the field bracket.
With the field bracket in hand, insert the two flexible
hooks located at the top of the bracket into the slots on
either side of the loudspeaker grid at the back of the
receiver and then tilt the receiver into place.
5. Attach the field bracket / ProMark3 combination onto the
tripod.
6. Connect the GPS antenna cable to the unit
7. Measure and record instrument height (HI) of GPS
antenna.
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Static Survey Setup (Base and Rover)
1. Turn on the receiver by pressing the
red key. Wait for
the ProMark3 workspace to appear on the screen.
2. Double-tap the Surveying icon to run the Surveying function. The screen displays the navigation screen that was
last displayed.
3. Make the settings required when first using the Surveying
function:
• Press the MENU key
• Tap Setup. In the Setup menu, tap successively the
options you need to set. Remember you need to define
the Storage medium (internal memory or SD card) and
the Receiver ID. Skip step 3 when next using the Surveying function.
4. Press the NAV key until you see the Satellite Status screen
(see opposite). Wait until at least 4 satellites are received.
5. When there is enough satellites received, press the LOG
key. The Survey Settings screen opens.

Satellite Status screen
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You must assign a unique
site ID to each point
surveyed.
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6. Enter the following parameters:
• Site ID: Tap inside the field and enter a 4-character
string using the virtual (on-screen) or real keyboard.
on the onThen press the ENTER key, or tap
screen keyboard, to validate the site ID.
• Survey Mode: For a static survey, tap the currently
selected mode and then tap Static.
• Site Description: (Optional) Tap inside the field and
enter a narrative description of the point (20 characters max.). Then press the ENTER key, or tap
on
the on-screen keyboard, to validate the content of this
field.
When several Site Descriptions have previously been
defined, you can quickly retrieve these by tapping the
left arrow to the right of the field. The list of existing
descriptions then appears in which you can tap the
desired one. This automatically sets the Site Description
field on the Survey Settings screen.
• Antenna Height: Tap inside this field and enter the vertical distance between the antenna and the surveyed
point. Be careful when entering the antenna height as
this field uses a fixed format (xx.xxx). Then press the
on the on-screen keyboard, to
ENTER key, or tap
validate the content of this field.
• Units: Tap inside this field and then tap the unit used
to express the antenna height (meters, US feet or Int
feet)

Slant

Vertical

• Height Type: Tap inside this field and then tap the
method used to measure the antenna height: Slant if
you measured the antenna height to the outside edge
of the GPS antenna, or Vertical if you measured the
antenna height to the bottom of the GPS antenna
mounting thread (see opposite).
• Recording Interval: Tap inside this field and then tap the
recording interval (time in seconds between any two
consecutive acquisitions of GPS data) you wish to use
in your static survey. Make sure the same recording
interval is used at the base and in the rover.
• Control Point check box: If you tap on this box to check
it, you will be able, later on, to use the point associated with this Site ID as a control point.

Data Collection
7. Tap the Log button at the bottom of the screen.
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The Static Survey screen opens providing information on
the status of your survey during the data collection period.

With an antenna that has
the best possible view of
the sky, you should have
#Sats continuously greater
than 4 and PDOP
continuously less than 4.
Obs. Range is equivalent to
Obs. Timer in ProMark2.

Information provided here will help you determine when
enough data has been collected.
• Obs. Range (Observation Range): Indicates the maximum length of the baseline that could be accurately
determined through post-processing considering the
amount of data currently collected. The more you collect data, the larger the value displayed in this field.
• Elapsed: Displays the amount of time since data storage began for the current observation session. The
update rate of this field is tied to the recording interval
you have chosen.
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• # Sats: Displays the current number of healthy satellites – seen above the elevation mask – being logged
into memory.
• PDOP: Displays the PDOP value at any given time,
computed from all observed healthy satellites above
the elevation mask.
• Site ID: Reminds you of the name you have given to the
point you are surveying.
• File Name: Indicates the name of the file in which data
is being collected. The file is automatically named by
the receiver according to conventions provided in
Appendices on page 192.
• Current Power and Memory statuses in graphical form.
8. When according to the Obs. Range parameter on the rover,
enough data has been collected in this observation session
(this implies that you must have a rough idea of the distance between the base and the rover), tap the Done button at the bottom of the screen or press the ENTER key.
9. Follow the steps presented above for each observation session required to complete your survey. After data collection is complete, take all ProMark3 receivers used in the
survey to the office and download the data to an office
computer as described in Office Work with GNSS Solutions Software on page 79. The data is now ready for postprocessing using GNSS Solutions.
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Introduction to Kinematic Surveying
The kinematic data collection process requires at least two receivers collecting data simultaneously.
One receiver is called the base and must remain stationary
throughout the data collection. Typically, the base receiver will
occupy a survey point for which the precise position is already
known.
Once operational, the base system simply collects and stores
raw data from all satellites with line of sight to the GPS antenna (cf. Static survey).
The kinematic base is essentially the same as a static occupation.
The other simultaneously operating GPS receiver(s) during a
kinematic survey is (are) designated as the rover(s). The rover
unit(s) can move during the survey and are used to position
new points relative to the base.
There are two types of kinematic survey supported by the
ProMark3 system:
• Stop-and-go (designated as “stop-and-go” in the receiver
menus)
• Continuous kinematic (designated as “kinematic” in the
receiver menus).

Stop-and-Go
Stop-and-go surveying is best suited for collection of points.
During Stop-and-go, the system is centered over a point and
collects data for a period of time. The occupation time for
stop-and-go will typically range from 15-60 seconds.
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It is highly recommended that a pole with bipod legs be used
for Stop-and-go data collection to insure that the antenna is
stable during this data collection period.
Once the point occupation is finished the system can be carried to the next survey point and the procedure is repeated.

Kinematic
Continuous kinematic data collection is suited for collecting
bulk points with minimal attributing (terrain modelling) or linear features such as a road centerline.
During continuous kinematic data collection the user never
has to stop moving. A point is collected every time the receiver
records a data record.
The recording interval for this application would typically be
1-5 seconds, and the accuracy is typically 0.03 to 0.05
meters.
The rover system is designed to be carried easily and is mounted entirely to a range pole.
Kinematic data collection has the advantage of high productivity. However there are some trade-offs to be considered. Accuracy is not as good as with GPS static data collection
methods (see data sheet for specifications). In addition, field
procedures require more planning and care.
Before beginning the kinematic survey, the rover unit must go
though an initialization stage. Initialization lasts from 15 seconds to 5 minutes depending on conditions. Procedures for
initialization will be described in detail later in this manual.
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During the kinematic data collection, the receiver must maintain lock on at least 5 satellites which are common at both the
base and rover stations.
If the receiver detects that less than 5 satellites are tracked,
it will send out an alarm indicating that the system must be
re-initialized.
In cases of loss of lock due to obstructions, it is possible that
the accuracy of processed results will be degraded if re-initialization is not performed in the field. Therefore, re-initialization in the field after a loss of lock is critical to maintaining
survey accuracy.
Finally, kinematic surveys are most successful when the kinematic base receiver is close to the kinematic rover. Accuracies
of GPS-derived positions are distance-dependent. The greater
the distance between the GPS receivers, the larger the uncertainty.
In an ideal case, the kinematic base should be on the same
project site as the kinematic rover. Kinematic surveys with a
separation of more than 10 kilometers (6 miles) between the
kinematic base and rover should be avoided. Such a separation makes kinematic initialization more difficult, increasing
the chances of poor results.
When performing a kinematic survey, ProMark3 provides you
with the tools to perform the following tasks:
• Manage data files in the GPS receiver
• Enter pertinent survey point attribute information required
for data processing
• Monitor the progress of the kinematic survey.
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Initialization Methods
The initialization phase is
required to ensure that
your kinematic surveys,
whether continuous or Stop
& Go, will reach
centimeter-level accuracies
through post-processing.
With the “Known” method,
you can make a survey at a
fairly long distance from
the base.

Three possible methods, from fastest to slowest:
• Known: Initialization on Known point.
Initialization achieved
in 15 seconds

Base

Rover

Init point can be several kilometers away from the base.
Known Point
This ve
ctor

is accura

tely know

n

Init point is a known
point

1. You have to enter the Site ID of the known point
2. GPS antenna held stationary over known point for about 15 seconds
3. Countdown indicates when initialization is achieved.

• Bar: On Initializer Bar Installed at the Base
Conversely, with the “Bar”
method (the method we
recommend), your survey
will necessarily start from
the base and obviously the
points to be surveyed
should not be too far away
from the base.

Initialization
achieved
in 5 minutes

1 Initializing...

2 Move antenna to range pole

Base

once countdown complete.

Rover

Init point is 20 cm
off the base location.
Known Point

1.
2.
3.
4.

You freely enter a Site ID for the rover’s start point
GPS antenna held stationary on the initializer bar for about 5 minutes.
Countdown indicates when initialization is achieved.
Move the antenna from the bar to the range pole taking care not to
mask the antenna while doing this. Then start your job

• <None>: On The Fly (OTF) Initialization
With the “<None>”
method, the survey start
point can be any point but
you should have a rough
idea of the distance from
your working area to the
base so you can estimate
the overall time you should
spend collecting data (15
to 30 minutes typical).

No initialization point

Base

Rover

Known Point

D

Rover’s start point is
an unknown point

1. You freely enter a Site ID for the rover’s start point
2. There is no countdown indicating when initialization is achieved.
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“Known” point means a point that is stored in the receiver’s
memory as a control point.
With the “Known” initialization method, the total duration of
the survey required for a successful survey increases with the
distance from the rover to the base.

Running a “Stop & Go” Survey
Base Setup and Operation

Allowing for kinematic
initialization using
Initializer bar at the base
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The base is setup and operated in the same way as it is in
static surveys (see page 45). The only difference is the possible use of the initializer bar at the base station.
The base antenna should be centered and levelled above the
known point. To be able to use the initializer bar for initialization, be sure to incorporate the bar as part of the base setup
as shown opposite. This bar gives an accurate baseline of 0.2
m (0.656 ft) for initialization.

Rover Setup
Install the unit on its range pole:
1. Attach the field bracket onto the pole.
2. Place the ProMark3 receiver into the field
bracket.
3. Connect the GPS antenna cable to the unit.
4. Mount the GPS antenna on top of the pole or,
in the case of a bar initialization, at the end of
the base’s initializer bar.
5. Connect the other end of the antenna cable to
the rover antenna.

1.
Temporary Setup for Bar Initialization:

2.

Setup for Known or <None> Initialization
(and Final Rover Setup after initialization step)

4.
5.

4.

3.
5.

3.

Stop & Go Survey Rover Setup
1. Turn on the receiver by pressing the
red key. Wait for
the ProMark3 workspace to appear on the screen.
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Satellite Status screen

Initialization method:
1) None
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2. Double-tap the Surveying icon to run the Surveying function. The screen displays the navigation screen that was
last displayed.
3. Make the settings required when first using the Surveying
function:
• Press the MENU key
• Tap Setup. In the Setup menu, tap successively the
options you need to set. Remember you need to define
the Storage medium (internal memory or SD card) and
the Receiver ID. Skip step 3 when next using the Surveying function.
4. Press the NAV key until you see the Satellite Status screen
(see opposite). Wait until at least 4 satellites are received.
5. When there is enough satellites received, press the LOG
key. The Survey Settings screen opens.
6. Tap inside the Survey Mode field and then tap Stop-and-go.
The content of the screen will be different depending on
the choice you make in the Initialize field (see below). This
is explained in detail below.
2) With initializer bar

3) On known position

Slant

Vertical

Enter the following parameters:
• Site ID and Site Description: Set these two parameters
after choosing the Initialization method (see below
after the Initialize parameter).
• Antenna Height: Tap inside this field and enter the vertical distance between the antenna and the surveyed
point. Be careful when entering the antenna height as
this field uses a fixed format (xx.xxx). Then press the
on the on-screen keyboard, to
ENTER key, or tap
validate the content of this field.
• Units: Tap inside this field and then tap the unit used
to express the antenna height (meters, US feet or Int
feet)
• Height Type: Tap inside this field and then tap the
method used to measure the antenna height: Slant if
you measured the antenna height to the outside edge
of the GPS antenna, or Vertical if you measured the
antenna height to the bottom of the GPS antenna
mounting thread (see opposite).
• Recording Interval: Tap inside this field and then tap the
recording interval (time in seconds between any two
consecutive acquisitions of GPS data) you wish to use
in your stop & go survey. Make sure the same recording
interval is used at the base and in the rover.
• Initialize: Choose the method to initialize the stop & go
survey (Known, bar or <None>; see page 55).
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Carefully choose the Site
ID!
Remember ProMark3 will
automatically increment
the Site ID as you progress
in your Stop-and-go survey. So make sure the
Site ID you choose will not
generate Site IDs that
already exist. If that was
the case, ProMark3 would
overwrite these Site IDs
without warning you.
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• Site ID: Set this parameter according to the initialization method you choose:
- If <None> or Bar is selected, you can freely enter a
Site ID from the keyboard. Tap inside the field and
enter a 4-character string using the virtual (onscreen) or real keyboard. Then press the ENTER
on the on-screen keyboard, to valikey, or tap
date the site ID.
- When you select Known, the receiver prompts you to
choose a Site ID from the list of existing control
points. Tap the desired Site ID.
• Site Description: (Optional) Tap inside the field and
enter a narrative description of the point (20 characters max.). Then press the ENTER key, or tap
on
the on-screen keyboard, to validate the content of this
field.
When several Site Descriptions have previously been
defined, you can quickly retrieve these by tapping the
left arrow to the right of the field. The list of existing
descriptions then appears in which you can tap the
desired one. This automatically sets the Site Description
field on the Survey Settings screen.
• Time on site (sec): If Bar or Known is selected as the Initialization method, enter the occupation time on site,
in seconds, required for initialization. If <None> is
selected as the Initialization method, enter the occupation time required on the first point you want to survey.

• Control Point check box: Displayed only if <None> is
selected in the Initialize field. If you check this box, you
will be able, later on, to use the start point -i.e. the
point where initialization took place- as a control
point.

Initialization Phase

Initialization count-down.

7. Tap the Log button at the bottom of the screen. This starts
data collection which will stop only at the end of the Stop
& Go survey. So be sure from now on, and until the end of
the survey, that you will not mask the antenna.
What happens after starting data collection depends on
the chosen initialization method:
• With Bar or Known selected, the receiver first goes
through an intermediate screen showing the countingdown of the initialization phase (see screen opposite).
The Remain field will count down beginning from the
value of the Time on site field set in the Survey Settings
screen. At the end of the countdown sequence, the
Remain field reads “00:00:00”.
If you are performing initialization on known point, you
are now ready to start the stop & Go survey. Continued
in next chapter Data Collection.
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If you are performing initialization on bar, you
now have to move the
rover antenna from the
initializer bar to the top
of the rover pole (see
illustration opposite).
While doing this, take
care not to mask the rover
antenna or else you would
have to resume the initialization.
• With <None> selected,
because there is no initialization phase,
ProMark3 directly
switches to data collection. Continued in next
chapter Data Collection.

Data Collection
8. Walk to the 1st point you want to survey, making sure you
will not mask the antenna.
9. If you have initialized on bar or known point, you may
need to change some of the survey settings (typically you
need to change the antenna height after moving the rover
antenna from the initializer bar to the pole).
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In this case, press the LOG key, which here is different
from tapping the on-screen Log button, and then review
and correct if necessary the following parameters:
- Site ID: Enter a name for the 1st point to be surveyed
- Site Description: (Optional) Tap inside the field and
enter a narrative description of the point (20 characters max.). Then press the ENTER key, or tap
on the on-screen keyboard, to validate the content
of this field.
When several Site Descriptions have previously been
defined, you can quickly retrieve these by tapping the
left arrow to the right of the field. The list of existing
descriptions then appears in which you can tap the
desired one. This automatically sets the Site Description
field on the Survey Settings screen.
- Antenna Height: After bar initialization, you need to
enter the new height of the rover antenna as it is
now located on top of the pole. After initialization
on known point, you should not have to change this
parameter.
- Initialize: Check that <None> is now selected.
- Time on Site: Enter the occupation time needed on
each point that you will survey (typically 15 seconds).
If you have selected <None> as the initialization method,
skip step 9.
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10.While holding the antenna pole stationary above this
point, tap Log on the screen. The receiver then displays
the screen below.

Make sure the rover
antenna has the best
possible view of the sky at
all times during the
survey. This should result
in #Sats continuously
greater than 4 and PDOP
continuously less than 4.
The Obs. Range field is
irrelevant to the Stop & Go
mode and for this reason
is left blank.

You may shorten the static
occupation time (i.e. end
the static occupation time
before Remain =00:00:00)
by tapping the Cancel
button. ProMark3 will then
take you directly to the
next screen on which the
Site ID will have normally
been incremented.
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Information provided here will help you determine when
enough data has been collected.
• Obs. Range (Observation Range): Field left blank as it
is irrelevant to Stop & Go survey.
• Remain: Displays the remaining amount of time during
which you should keep the antenna stationary over the
surveyed point. At the end of the countdown, you can
walk to the next point.
• # Sats: Displays the current number of healthy satellites – seen above the elevation mask – being logged
into memory.

• PDOP: Displays the PDOP value at any given time,
computed from all observed healthy satellites above
the elevation mask.
• Site ID: Reminds you of the name given to the point you
are surveying.
• File Name: Indicates the name of the file in which data
is being collected. The file is automatically named by
the receiver according to conventions provided in
Appendices on page 192.
• Current Power and Memory statuses in graphical form.
11.Wait until Remain = 00:00:00. The receiver then displays
the screen below:
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0001

0002

Rover
0003

0004
0007

0006

0005

Cross points indicate
where static occupations
take place.
The line indicates
continuous data
collection, from the first to
the last point.

Note that the content of the Site ID field is incremented by
1 after ending static occupation on a point (increment: 0
to 9, then A to Z, then 0.. again, etc.). You can however
change the Site ID between any two occupation times by
pressing the LOG key (not the on-screen LOG button) and
editing the Site ID field.
12.Move to the next point and resume the above two steps
until all the points have been visited.
13. Tap Done after surveying the last point. This completes the
data collection phase.

Running a Kinematic Survey
Base Setup and Operation

Allowing for kinematic
initialization using
Initializer bar at the base
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The base is setup and operated in the same way as it is in
static surveys (see page 45). The only difference is the possible use of the initializer bar at the base station.
The base antenna should be centered and levelled above the
known point. To be able to use the initializer bar for initialization, be sure to incorporate the bar as part of the base setup
as shown opposite. This bar gives an accurate baseline of 0.2
m (0.656 ft) for initialization.

Rover Setup
Install the unit on its range pole:
1. Attach the field bracket onto the pole.
2. Place the ProMark3 receiver into the field
bracket.
3. Connect the GPS antenna cable to the unit.
4. Mount the GPS antenna on top of the pole or,
in the case of a bar initialization, at the end of
the base’s initializer bar.
5. Connect the other end of the antenna cable to
the rover antenna.
6. Measure the antenna height.

1.

Temporary Setup for Bar Initialization:

2.

Setup for Known or <None> Initialization
(and Final Rover Setup after initialization step)

4.
5.

4.

3.
5.

3.

Kinematic Survey Rover Setup
1. Turn on the receiver by pressing the
red key. Wait for
the ProMark3 workspace to appear on the screen.
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Satellite Status screen

Initialization method:
1) None
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2. Double-tap the Surveying icon to run the Surveying function. The screen displays the navigation screen that was
last displayed.
3. Make the settings required when first using the Surveying
function:
• Press the MENU key
• Tap Setup. In the Setup menu, tap successively the
options you need to set. Remember you need to define
the Storage medium (internal memory or SD card) and
the Receiver ID. Skip step 3 when next using the Surveying function.
4. Press the NAV key until you see the Satellite Status screen
(see opposite). Wait until at least 4 satellites are received.
5. When there is enough satellites received, press the LOG
key. The Survey Settings screen opens.
6. Tap inside the Survey Mode field and then tap Kinematic.
The content of the screen will be different depending on
the choice you make in the Initialize field (see below). This
is explained in detail below.
2) With initializer bar

3) On known position

Slant

Vertical

Enter the following parameters:
• Site ID and Site Description: Set these two parameters
after choosing the Initialization method (see below
after the Initialize parameter).
• Antenna Height: Tap inside this field and enter the vertical distance between the antenna and the surveyed
point. Be careful when entering the antenna height as
this field uses a fixed format (xx.xxx). Then press the
on the on-screen keyboard, to
ENTER key, or tap
validate the content of this field.
• Units: Tap inside this field and then tap the unit used
to express the antenna height (meters, US feet or Int
feet)
• Height Type: Tap inside this field and then tap the
method used to measure the antenna height: Slant if
you measured the antenna height to the outside edge
of the GPS antenna, or Vertical if you measured the
antenna height to the bottom of the GPS antenna
mounting thread (see opposite).
• Recording Interval: Tap inside this field and then tap the
recording interval (time in seconds between any two
consecutive acquisitions of GPS data) you wish to use
in your kinematic survey. Make sure the same recording interval is used at the base and in the rover.
• Initialize: Choose the method to initialize the kinematic
survey (Known, bar or <None>; see page 55).
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Carefully choose the Site
ID!
Remember ProMark3 will
automatically increment
the Site ID as you progress
in your Kinematic survey.
So make sure the Site ID
you choose will not generate Site IDs that already
exist. If that was the case,
ProMark3 would overwrite
these Site IDs without
warning you.

• Site ID: Set this parameter according to the initialization method you choose:
-If <None> or Bar is selected, you can freely enter a Site
ID from the keyboard. Tap inside the field and enter
a 4-character string using the virtual (on-screen) or
real keyboard. Then press the ENTER key, or tap
on the on-screen keyboard, to validate the site
ID.
-When you select Known, the receiver prompts you to
choose a Site ID from the list of existing control
points. Tap the desired Site ID.
• Site Description: (Optional) Tap inside the field and
enter a narrative description of the point (20 characters max.). Then press the ENTER key, or tap
on
the on-screen keyboard, to validate the content of this
field.
When several Site Descriptions have previously been
defined, you can quickly retrieve these by tapping the
left arrow to the right of the field. The list of existing
descriptions then appears in which you can tap the
desired one. This automatically sets the Site Description
field on the Survey Settings screen.
• Time on site (sec): If Bar or Known is selected as the Initialization method, enter the occupation time on site,
in seconds, required for initialization. If you select
<None>, this field is removed from the screen.

Initialization Phase
7. Tap the Log button at the bottom of the screen. This starts
data collection which will stop only at the end of the Kinematic survey. So be sure from now on, and until the end of
the survey, that you will not mask the antenna.
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Initialization count-down.

What happens after starting data collection depends on
the chosen initialization method:
• With Bar or Known selected, the receiver first goes
through an intermediate screen showing the countingdown of the initialization phase (see screen opposite).
The Remain field will count down beginning from the
value of the Time on site field set in the Survey Settings
screen. At the end of the countdown sequence, the
Remain field reads “00:00:00”.
If you are performing initialization on known point, you
are now ready to start the stop & Go survey. Continued
in next chapter Data Collection.
If you are performing initialization on bar, you
now have to move the
rover antenna from the
initializer bar to the top
of the rover pole (see
illustration opposite).
While doing this, take
care not to mask the rover
antenna or else you would
have to resume the initialization.
• With <None> selected,
because there is no initialization phase,
ProMark3 directly
switches to data collection. Continued in next
chapter Data Collection.
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Data Collection
8. Walk to the start point of the trajectory you want to survey,
making sure you will not mask the antenna.
9. If you have initialized on bar or known point, you may
need to change some of the survey settings (typically you
need to change the antenna height after moving the rover
antenna from the initializer bar to the pole).
In this case, press the LOG key, which here is different
from tapping the on-screen Log button, and then review
and correct if necessary the following parameters:
- Antenna Height: After bar initialization, you need to
enter the new height of the rover antenna as it is
now located on top of the pole. After initialization
on known point, you should not have to change this
parameter.
- Initialize: Check that <None> is now selected.
If you have selected <None> as the initialization method,
skip step 9.
10.Tap the on-screen Log button and then walk along the trajectory. The screen then looks like this:

Make sure the rover
antenna has the best
possible view of the sky at
all times during the
survey. This should result
in #Sats continuously
greater than 4 and PDOP
continuously less than 4.
The Obs. Range field is
irrelevant to the kinematic
mode and for this reason
is left blank.
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Information provided here will help you monitor the survey
of the trajectory.
• Obs. Range (Observation Range): Field left blank as it
is irrelevant to Kinemativ survey.
• Elapsed: Displays the time elapsed, in hours, minutes,
seconds, since you tapped the Log button (at the begginning of the trajectrory).
• # Sats: Displays the current number of healthy satellites – seen above the elevation mask – being logged
into memory.
• PDOP: Displays the PDOP value at any given time,
computed from all observed healthy satellites above
the elevation mask.
• Site ID: Indicates the name of the last logged position
along the trajectory.
• File Name: Indicates the name of the file in which data
is being collected. The file is automatically named by
the receiver according to conventions provided in
Appendices on page 192.
• Current Power and Memory statuses in graphical form.
As you are progressing along the trajectory, the content of
the Site ID field will be incremented by 1 at the recording
interval rate (increment: 0 to 9, then A to Z, then 0..
again, etc.).
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Log

0001...

Rover

00014...
0015...

Pause
Log

0028

Bold lines indicate the
trajectories surveyed.
Data collection is NOT
suspended between the
trajectories.
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11.Use the buttons at the bottom of the screen to do the following:
• Pause: Tap this button when you arrive at the end of
the trajectory. Remember tapping this button does not
mean that you stop data collection: actually data collection continues! When you tap Pause, the button is
then renamed “Log”. Tap the Log button when you are
at the start point of a new trajectory you want to survey..
• Done: Will end the kinematic survey by closing the
data file and taking you back to the last displayed navigation screen. This ends data collection. (After selecting Done, the receiver is idle but still in the Surveying
function.)

Re-Initialization
When is Re-Initialization Required?
Re-initialization is required when the following message appears on the screen, due to poor GPS reception, while you are
running a Stop & Go or Kinematic survey that you initialized
through the “Bar” or “Known” initialization method:

When this occurs, you will unfortunately have to resume all or
part of your survey. The reason for this is that due to a break
in the flow of collected data, the post-processing software will
not be able to deliver the expected level of accuracy for all
those points that you might have surveyed AFTER the data
break.
Following the occurrence of this message, tap anywhere outside of the message window to acknowledge the Reinitialize
alarm. Then resume the survey from the last control point you
surveyed (see next section).
The next section describes a preventive procedure that you
can use to better respond to possible re-initialization requirements.
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Preventive Steps to Facilitate Re-initialization
If you take care to create “intermediate” control points as you
are progressing in your stop-and-go surveys, you will make reinitialization easier in the sense that you will not have to resume the survey from the beginning. Instead, you will just
have to walk back to the last “intermediate” control point you
will have surveyed and run a new initialization on this point
using the “Known” option. Kinematic surveys conducted in
the vicinity can also benefit from this intermediate control
point should they undergo the same re-initialization problem.
1. Creating an intermediate control point
A couple of times during your stop & go surveys:
• Spot a location where reception is particularly good and
where it is easy to come back (the location should clearly
be marked one way or another).
• Keep still on that point.
• Press LOG (which here is different from tapping the onscreen Log button).
• Change the Site ID. Keep in mind the Site ID that is displayed (e.g. “1034”) and the one you enter (e.g. “CP10”).
• Check the Control Point option and tap Log.
• Keep still until the Remain field is zeroed.
• Then press LOG again, re-enter the former Site ID
(“1034”), clear the Control Point option and continue with
your survey.
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2. Re-initializing on an intermediate control point
If the “Loss of Lock. Reinitialize” message arises when you
are performing a Stop & Go survey:
• Acknowledge the alarm by tapping anywhere outside of
the message window.
• Walk to the control point you last surveyed.
• Check that you have enough satellites and a good PDOP
on that point
• Press the LOG key.
• Select “Known” in the Initialize field, then tap the Site ID
corresponding to this point (remember in our example you
named that point“CP10”).
• Tap Log and wait for the Remain field to countdown to zero.
• Walk to the point where the alarm message occurred keeping the pole range always vertical and making sure the
antenna has continuously an open view of the sky.
• When you have arrived at the point, press the LOG button,
rename the Site ID and continue with your survey.
If the “Loss of Lock. Reinitialize” message arises when you
are performing a Kinematic survey:
• Acknowledge the alarm by tapping anywhere outside of
the message window.
• Tap Done to close the observation file.
• Walk to the control point you last surveyed.
• Check that you have enough satellites and a good PDOP
on that point
• Press the LOG key.
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• Select “Kinematic” as the Survey mode
• Select “Known” in the Initialize field, then tap the Site ID
corresponding to the “intermediate” control point (remember in our example you named that point “CP10”).
• Tap Log and wait for the Remain field to countdown to zero.
• Walk to the beginning of the trajectory you were surveying
when the alarm message occurred.
• Press the LOG key, rename the Site ID.
• Tap Log to resume the survey of the trajectory you have not
been able to complete the first time.

Quitting the Surveying Function
Press the MENU key and tap Exit. This takes you back to the
ProMark3 workspace screen.
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Office Work with GNSS Solutions Software
Do not forget to double-tap
the Surveying icon or else
no communication will be
possible between ProMark3
and the PC.

Downloading Field Data from ProMark3
Back in your office, do the following to download your field
data. It is assumed that GNSS Solutions has already been
installed on your PC.
1. On ProMark3:
- Turn on the receiver.
- Double-tap the Surveying icon.
- Make sure the ProMark3 Storage option setting will
allow the Download utility to access the desired files.
For example, if the files to be downloaded are on the
SD Card, make sure SD Card is selected as the Storage
option. To set this information, press the MENU key
then select Setup then Storage.
2. Clip the I/O module as shown opposite.
3. Connect the USB cable between the ProMark3 unit and
your PC (see opposite).
You can also use a serial cable (RS232) with female DB9
connectors that you connect between your PC and COM1
on ProMark3’s I/O module (see page 4) but the downloading times will be longer than with USB..
The first time you connect ProMark3 to the office PC
via USB, you may be asked to install a USB driver on the
PC (although this driver should normally have been
installed when installing GNSS Solutions). This driver is
located on the GNSS Solutions CD in the “.../USB Driver/
PROMARK/” folder. Once you have inserted the CD in your
CD drive, ask the PC to search for this driver on the installation CD and then follow the on-screen instructions to
complete the driver installation.
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It is very important that you
connect the ProMark3 to
the PC BEFORE running
Download.

If you have some difficulty
identifying which port
number should be selected
as the USB port, first run
Download WITHOUT the
USB connection to
ProMark3 in order to list
the available ports. Then
quit Download and resume
the operation after
connecting ProMark3. An
additional port will then
appear in the list. This
additional port is precisely
the port you need to select
to allow communication
with ProMark3 via USB.
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4. On the PC:
- From the Windows task bar, select Start>Programs>GNSS Solutions>Tools>Download.
(Double-click
in the right side of the window if
you want to change to the parent directory and open
your project folder on the PC.)
- In the Download window, select File>Connect>Receiver>Connect via Cable. This opens the Connect Via Cable dialog.
- In this dialog, choose the port created on the PC following the installation of the USB driver and then click
OK. (If you use an RS232 cable, just select the corresponding port number and click OK). The following
appears successively in the status bar, at the bottom of
the window:
Looking for remote on COMx at xxxx Baud...
Connected to Data Source
Setting Baud rate...
Preparing for listing...
Directory has been listed
The left side of the Download window then lists the
files present in the ProMark3.
- Select the files you want to download. If necessary,
hold down the Ctrl key to make a multiple selection.
- Press the F5 key or drag and drop the selected files
from the left to the right side of the window. A Copying
file dialog appears during data transfer.

Files resulting from the
downloading of an
observation file are named
as follows:
X<Downloadedfilename>
where prefix X = “E” for
Ephemeris Data, “B” for
Position Data, “D” for GPS
Raw Data and “W” for
SBAS Data.

After the transfer is complete, notice in the right side
of the Download window that each downloaded file has
been split into different files named with different prefixes (see opposite).

- Close the Download window.
5. On ProMark3, quit the Surveying function, turn off the
receiver and remove the cable between the PC and
ProMark3.
6. Repeat the previous 5 steps for each of the ProMark3
units involved in the project to download their respective
files to the same project folder on your office computer.
Note that you can also download your field data from the
SD card that you have previously removed from the
ProMark3 and inserted into the local SD Card reader. The
procedure is the same as above except that there is no
connection to a remote device needed.
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Downloading Field Data from the Local SD Card
Reader
If your field data were logged on the SD Card, you can also
download the field data from your local SD card reader if there
is one.
- Extract the SD card from the ProMark3 and insert it into
your local SC card reader.
- From the Windows task bar, select Start>Programs>GNSS
Solutions>Tools>Download.
- (Double-click
in the right side of the window if you
want to change to the parent directory and open your
project folder on the PC.)
- In the Download window, select File>Connect>PC drive. As a
result, the left side of the window shows the file structure
of your PC.
- On top of the left side of the window, click on the down
arrow and select the letter corresponding to your local SD
card reader (for example “G:”). You can now see the field
data files stored on the SD card.
- In the left side of the window, select the files you want to
download. If necessary, hold down the Ctrl key to make a
multiple selection.
- Press the F5 key or drag and drop the selected files from
the left to the right side of the window. A Copying file dialog appears during data transfer.
As explained on page 81, each downloaded file is split
into different files with different prefixes. These files can
be seen in the right side of the window once the downloading is complete.
- Close the Download window.
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Post-Processing Field Data
1. On your office computer, launch GNSS Solutions
2. Click Create a New Project, enter a project name and then
click OK.
3. Click Import Raw Data from Files.
4. Browse your computer to change to the folder containing
the data files you have just downloaded.
5. Select the files you want to import and click Open. The
Importing GPS Data dialog lists the files you want to import
(top). Each row describes one of these files (filename,
associated Site ID, etc.)

6. At the bottom of the window, define which of the sites is
the control point (base) and enter or check its known coordinates. You can also fix the control point if necessary by
selecting one of the options available in the Fixed column.
If you select <Blank>, the point won’t be fixed.
Press
in the top-right corner of the window if you
have some doubt on which Site ID is the base. Pressing
this button will show all the observation files vs. time.
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The longest observation is likely to be the one recorded at
the base. Refer to the GNSS Solutions Reference Manual
for more information.
7. Click OK>To Import to import the data into the project.
Depending on the type of survey, you can go even faster by
running, in one operation, the Import, Process and Adjust
functions.

Uploading a Vector Background Map to ProMark3
Vector background maps are generated from DXF, SHP or MIF
files imported in a GNSS Solutions project.
Note that raster background maps CANNOT be uploaded to
ProMark3 in its current version.
Assuming the ProMark3 unit is connected to the PC via the
USB cable, it has been turned on and you have double-tapped
the Surveying icon, do the following on PC side:
- Launch GNSS Solutions and then open the project containing the vector map you want to upload to ProMark3.
- In the Command pane on the left, click the Map topic bar
and then the Upload Maps to External Device icon. GNSS
Solutions then automatically detects the presence of the
ProMark3 on the USB port and also lists the project maps
that can be uploaded.
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Here is a screen example that you could see at this stage:

- Name the file and then click OK. The following messages
appear in succession during the map upload process:
Preparing data..
Creating data
Creating output image file...
Connecting... USBx
Uploading to GPS

-

While the last message above is displayed, a message on
the ProMark3 screen informs you that the <map
name>.imi file is being uploaded.
When the file transfer is complete, press MENU, tap Setup
and then Select Map.
Tap in the Detail Map field and then select the name of the
file you have just uploaded
Tap Save. ProMark3 starts loading the new map. After a
while, the Map screen is displayed.
Use the IN, OUT and scrolling buttons to get a full view of
the new map on the Map screen.
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Uploading Control Points to ProMark3

Control points can only be
uploaded to the ProMark3’s
internal memory!

Ctrl
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Wpt

You can uploads control points from an open GNSS Solutions
project to your ProMark3. Reference and target points CANNOT be uploaded.
To know the definition of each of these point types, please
read the “Point Properties” section in the GNSS Solutions
Reference Manual (in Chapter 5).
During this operation, GNSS Solutions will transform fixed
control points into control points (for stop & go or kinematic
initialization) and non-fixed control points into waypoints.
Fixed control points can only be uploaded to the ProMark3’s
internal memory, not on the SD card. So make sure the internal memory is used as storage medium on the ProMark3 when
uploading your control points (press MENU, tap Setup, Storage, Internal Memory and then OK).
NOTE: You can also keep “SD Card” as the storage medium
and temporarily remove the SD card from the unit before
running the upload function. In this configuration, i.e. in the
absence of the SD card, the upload function will in fact load
the control points into the internal memory. After you re-insert the SD card into the unit and you start a survey, data will
be saved to the SD card, as requested by the Storage setting.
Fixed control points will also be available as waypoints in the
ProMark3. On the map screen, these will appear as small yellow triangles whereas “normal” waypoints will continue to appear using the usual representation (a yellow cross square).
See opposite.

Uploading control points, whether fixed or not, will always
overwrite the complete list of control points currently available
in the ProMark3. This means for example that there won’t be
any control points left in the ProMark3 if the selection of
points you wish to upload does not include a single fixed control point.
As a general rule, you should therefore upload all the control
points and waypoints you need through a single upload operation.
The names of the uploaded points will be truncated to 4 characters for control points and 8 characters for waypoints. Consequently, make sure the points you select will keep different
names after truncation or rename those points that would otherwise have similar names after truncation.
Finally, you can choose whether the points you upload as waypoints will add up to the list of existing waypoints or will replace this list (at one step during the uploading, you will have
to check or clear the Erase existing waypoints option).
Assuming the ProMark3 unit is connected to the PC via USB
(or RS232), it has been turned on and you have doubletapped the Surveying icon, do the following on PC side:
- Launch GNSS Solutions and then open the project containing the control points you want to upload to ProMark3.
- Select the control points you want to upload (select them
on the Survey View or on the Points tab in the workbook).
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- In the Command pane on the left, click the Export topic
bar and then the Upload Positions to External Device icon. In
the new dialog that opens, select Control & Waypoints:

- Click OK. GNSS Solutions then automatically detects the
presence of the ProMark3 on the USB port.
In the dialog that opens, make the appropriate selections
and choose the right port to communicate with ProMark3:
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- Click OK. The following messages appear in succession
during the point upload process:
Connecting... USBx
Uploading control points and
waypoints...
- The points you have uploaded can now be seen on the
ProMark3 using the following procedure:
• Press MENU and tap Exit
• Double-tap Surveying
• Press LOG
• Select Stop-and-go or Kinematic as the Survey Mode
• In the Initialize field, select Known. The list of available
control points now appears in which you can recognize
the points you have uploaded.
• Press ESC
• Press MENU and tap GOTO
• Tap User Waypoint, then Position. The list of available
user waypoints now appears in which you can recognize the points you have uploaded.
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4. Mobile Mapping
Feature Libraries
A feature library is a hierarchical structure that guides
you through the description
process so you know you
will describe thoroughly
and quickly each feature
you visit. You will not have
to remember what
attributes of each feature
you should record: the feature library will tell you!
Example of a “streetlight”
point feature, as may be
described in a feature
library
List Attribute
of streetlight values
attributes

Condition

# of bulbs
Closest
Street
Address

- Good
- Needs repair
- Needs paint
Enter
numeric value

Type in
address

Feature libraries are created using the Feature
Library Editor module in
MobileMapper Office.
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Feature libraries contain lists of features that you should be
visiting during your field sessions.
Features are four types:
- Point feature: The geometrical representation of this feature is a point. Logging this type of feature requires static
occupation at the point.
- Line feature: The geometrical representation of this feature is a line. Logging this type of feature requires that you
move along this line.
- Area feature: The geometrical representation of this feature is an area. Logging this type of feature requires that
you move along its contour.
- Grid feature: The geometrical representation of this feature is an array of evenly-distributed waypoints. ProMark3
will guide you to each of these waypoints where you
should enter a measurement performed at this point.
Each feature also has a number of attributes. There are three
categories of attributes:
- Menu style where the attribute values are words or phrases
that you pick off a list (e.g. a list of values for the attribute
Condition might include Good, Needs Repair, etc.; see
opposite)
- Numeric style where you select a number within a specified range (e.g. the # of bulbs might be in the range 0 to
3)
- Text style where you type in a note that can contain both
numbers and letters (e.g. the closest street address)

You can upload as many feature libraries as you want into
ProMark3. Just remember that you can use only one feature
library for logging data to an individual job.

Logging New GPS/GIS Data
(Remember you can use the real-time DGPS capability if you
need it. See Implementing Real-Time DGPS on page 182.)
1. Turn on the receiver by pressing the
red button.
2. Double-tap the Mobile Mapping icon.
3. Press the NAV key until you see the Satellite Status screen
(see opposite) Wait until at least 4 satellites are received.
For the best accuracy it is important to hold the receiver at
an angle of 45° from horizontal and not too close to you.

Satellite Status screen

45°

4. Follow the instructions below to log GIS features.
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1. Creating a Job and Selecting a Feature Library
- Press the LOG button
- Tap Create New Job. The screen displays the Job Name
field in which you should enter the name of the new
job. A keyboard is displayed underneath to let you
enter this name.
To enter a name, tap on the corresponding letters on
the keyboard.

Entering a job name
Note that each ProMark3
includes a "Generic" library
containing default features. This library contains
a point feature, a line feature, an area feature and a
grid feature. Each of these
features has a single textstyle attribute. Use this
library only as a “backup”
library.
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- When you have finished entering the name, tap
on
the on-screen keyboard or press the ENTER key. A new
screen is then displayed listing the feature libraries
stored in ProMark3.
- Tap the name of the feature library you want to use. A
new screen is then displayed asking you to choose the
job mode:
• Real-time: If you select this job mode, the receiver
will record only feature positions and descriptions
and GPS metadata. Jobs recorded in real-time mode
cannot be differentially corrected later on.
• Post-processing: Select this job mode to allow
ProMark3 to record the job so that later on, it can be
post-processed in MobileMapper Office. In this job
mode, ProMark3 will record GPS measurements files
in addition to the MMJ job file that is recorded in
real time. For more information, see MobileMapper
Office User Manual.
- Tap one of these modes. The screen now lists all the
features available from the selected feature library.

ProMark3 uses a fixed,
time-based logging interval (1 second) when you
log a point feature. The
logging interval parameter
cannot be accessed when
you log a point feature.

Logging screen
The Logging screen also
displays the time elapsed
since you started logging at
this point feature, the
number of satellites currently received and the current value of PDOP (see
also page 107).
If you start logging a new
feature and you realize this
is a mistake, then you can
delete the new feature
being logged by tapping
the Options button and
selecting Delete <feature
name>.
Deleting features only
applies to new features
being logged, not to features already logged.

2. Logging and Describing a Point Feature
- Choose the type of feature you want to log from this
list. You can tell by the name of this feature whether it
is a point feature, a line feature or an area feature.
- Tap a point feature (you are supposed to be near one of
these features) and tap the on-screen Log button. This
starts feature logging. A sound is heard every time
ProMark3 logs data.
The Logging screen is now displayed where you can
see the list of attributes pertaining to this feature. You
will now enter the “Description” phase of the feature.
- Tap the first attribute and enter the right attribute
value describing the feature near you. This takes you
back to the Logging screen.
- Highlight the next attribute in the list and repeat the
previous step. Repeat this step until all the attributes
have been properly described.
“Describing” the feature only takes a few seconds. By
the time you are done with the feature description, the
feature’s GPS position will have been saved in the job.
You can also stay more time on the feature to let the
receiver determine several positions. This will give an
even more accurate position for the feature as
ProMark3 will average all the GPS positions it has
computed on the feature.
- To stop logging the feature, tap Done. This takes you
back to the Feature List screen
- Move to the next feature and resume the above
instructions to log this feature.
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3. Logging and Describing a Line Feature
Basically, you use the same procedure as when you log a
point feature (see 2. above). There are however two differences when you log a line feature:
- You need to define a logging interval when you start
logging the feature
- And then you are supposed to move from the beginning to the end of the line feature before stopping the
logging.
These differences are explained below.
After tapping a line feature from the Feature List screen
(for example a road) and tapping the Log button,
ProMark3 starts logging GPS positions from the position
where you are. The default logging interval is 5 seconds.
By decreasing the logging interval you can increase the
level of detail in your maps. By increasing the logging
interval, you can save memory. In general, you should set
the logging interval to the smallest setting possible without running out of memory. Remember you can take multiple SD cards with you to the field. The only requirement is
that you close the job file before replacing the SD card.
To change this interval:
- Tap Options on the screen and then Logging Interval.

Selecting the logging interval option

94

Logging screen

The Logging screen also
displays the distance traveled since you started logging the line feature, the
number of satellites currently received and the current value of PDOP (see
also page 125).

Two options are then prompted:
By Time: Select this option when you want to log a new
GPS position at regular intervals of time regardless of
the distance traveled since the last position logged.
After tapping this option, tap the desired time interval.
This takes you back to the Logging screen where you
can see the list of attributes pertaining to the feature.
By Distance: Select this option when you want to log a
new GPS position only after you have moved by a certain distance since the last position logged. After tapping this option, tap the desired distance interval. This
takes you back to the Logging screen where you can
see the list of attributes pertaining to the feature.
- As you would for a point feature, describe the feature
by describing the different attributes pertaining to the
feature
- When the description is finished, you can start walking
along the line feature
- When you arrive at the end of the line feature, with
ProMark3 still displaying the Logging screen, tap Done
to stop logging the feature.
The receiver determines the length of a line feature by
estimating the distance between successive points on the
line feature with the assumption that each point is on a
sphere of average Earth radius. The elevations of the
points are not factored into the equation. Thus the
receiver calculates the spherical distance rather than the
horizontal or slope distance between the successive positions.
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If you wish to change the logging interval while you are
logging a line feature, you first need to pause the logging
of the feature:
- Tap Options and then Pause <line feature name>
- Tap Options again and then Logging Interval. Set the
new logging interval as explained above.
- After changing the logging interval, tap Options and
then Resume <line feature name>. The receiver will continue to log the feature, but this time according to the
new logging interval.
4. Logging and Describing an Area Feature
Basically, you use the same procedure as when you log a
line feature, especially regarding the need for defining a
logging interval (see 3. above). The only difference
between a line and area feature is that for an area feature,
the first and last position calculated by the receiver are
connected when you close the feature.

Logging screen

This screen displays the
current values of perimeter and area measured
since you started logging
the feature (+ number of
satellites and PDOP)
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Record the attributes of an area feature as you do for a
line feature (see page 94):
- Tap the name of the area feature from the list of features and tap the Log button. ProMark3 starts logging
the area feature.
- Choose a logging interval (see explanations given for a
line area on page 95). This takes you back to the Logging screen where the list of attributes for the feature
is displayed
- Describe each attribute by selecting or entering the
appropriate attribute value for each of them.

The receiver determines the perimeter of an area feature
by estimating the distance between successive points on
the line feature with the assumption that each point is on
a sphere of average Earth radius. The elevations of the
points are not factored into the equation. Thus the
receiver calculates the spherical distance rather than the
horizontal or slope distance between the successive positions. The perimeter of the area feature is the sum of all
these distances. For the same reason, the measured area
is that of a curved, not flat, feature.

Selecting the Pause Park
option

5. Pausing a Feature
When you are recording lines or areas, it is sometimes
impossible to walk or drive the entire length of the feature
because of obstacles in your way such as fences, buildings, bodies of water, etc. When you must interrupt the
recording of any feature (excluding point features), follow
these steps:
- Tap Options and then Pause <feature name>. This pauses
the logging of the feature.
- Move around the obstacle to the next accessible portion of the feature
- To resume logging, tap Options and then Resume <feature name>. This resumes the logging.
- When you finish logging the feature, just tap Done.
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Selecting the Repeat
Attributes option

6. Logging New Features with Same Attributes as Those Set
in the Previously Logged Feature
If you close a point, line or area feature and want to log
the location of another feature of the same type and with
an identical description, use the Repeat Attributes function.
After closing a feature, ProMark3 takes you back to the
Feature List screen on which the same feature type is still
selected. Just do the following:
- Move to the next similar feature you want to log.
- Tap Log to start logging the new feature.
- Tap Options and then Repeat Attributes. As a result, all
the attributes of the previously logged feature are
immediately assigned to the feature been logged.
- After logging the GPS position(s) of this feature, tap
Done to close the feature.
7. Nesting a Feature
When you are logging GPS positions to a feature, you may
find another feature that you also want to log. Rather than
log the entire feature and come back to record this other
feature, you can simply pause the feature being logged,
log the other feature, close it and resume logging the first
feature.
Logging one feature while you have paused another feature is called “nesting.” You can nest any feature, point
line or area, into any line or area feature. It is not possible
to nest a point feature inside another point feature.
Nesting is particularly useful when you are mapping things
such as a road with streetlights along the route or a shoreline with stretches of erosion along it and the locations of
certain habitats.
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Assuming you are logging a line feature and the Logging
screen is displayed, do the following, for example to nest a
point feature:
- Tap Options and then Pause <feature name>. This pauses
the logging of the line feature.
- Tap Options again and then Nest Feature
- Move to the location of the feature you want to nest
- In the Feature List screen now displayed, tap the feature type you want to nest.
- Tap Log to start logging this feature.
- Describe the attributes of the feature as explained
above
- Tap Done when you have finished logging the nested
feature.
- Tap Options and then Resume <feature name>. This takes
you back to the Logging screen from which you can
normally finish the logging of the line feature.
8. Offsetting a Point Feature
Sometimes the feature you want to put on the map is in
area of poor GPS reception or is not accessible. This is
when you can map the feature using the offset utility. By
combining the receiver’s position with the bearing and distance to the feature, ProMark3 will automatically calculate and record the position of the feature.
To input an offset for a point feature, assuming the Feature List screen is now displayed, do the following:
- Tap one of the listed point features available from the
selected feature library.
- Tap Log to start logging the feature
- Tap Options and then Offset.
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Point Offset screen

If you do not have a compass, you can use
ProMark3’s Compass
screen (see also page 128)
to determine the bearing to
the offset feature. If you
have been moving for 5 to
10 seconds along a
straight line, the Compass
screen will tell you your
bearing. You can use this
to determine the bearing to
the offset feature. CAUTION! The receiver cannot
determine direction while
stationary and the compass
direction remains the same
even if you rotate the
receiver.
Visual estimation for horz.
& vert. distances is usually
good enough in terms of
accuracy.
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This displays the Point Offset screen on which you
should enter the following parameters:
Bearing: Compass direction to the feature from your
current position. You need a compass to measure this
angle (see also opposite). To input a value for Bearing,
press ENTER and type in the new value from the keyboard or the on-screen keyboard. Then press ENTER
again.
Press the down arrow to move the cursor to the next
field.
Horz. Distance: Horizontal distance to the feature from
your current position. To input a value for Horz. Distance, press ENTER and type in the new value from the
keyboard or the on-screen keyboard. Then press
ENTER again.
Press the down arrow to move the cursor to the next
field.
Vert. Distance: Vertical distance to the feature from your
current position (“0” if the feature and yourself are at
the same elevation -on a flat area). To input a value for
Vert. Distance, press ENTER and type in the new value
from the keyboard or the on-screen keyboard. Then
press ENTER again.
Press the down arrow to move the cursor to the next
field.
- Then tap OK to return to the Logging screen. This
writes the offset into memory, but you can edit it later
if you like by going through the same process. If you
close the feature and return to the Map screen, you
will see that the feature is offset from your position in
the middle of the screen.

Line or Area Offset screen

Line

Area

On the left

On the right

Visual estimation for horz.
& vert. distances is usually
good enough in terms of
accuracy.

9. Offsetting a Line or Area Feature
For the same reasons as a point feature (see previous
page), you may need to use the offset utility to map a line
or area feature. By combining the receiver’s position with
the direction and the distance to the feature, ProMark3
will automatically calculate and record the location of the
feature.
To input an offset for a line or area feature, assuming the
Feature List screen is now displayed, do the following:
- Tap one of the line or area features available from the
open feature library.
- Tap the Log button to start logging the feature.
- Tap Options and then Offset. This displays the Line or
Area Offset screen on which you should enter the following parameters:
Direction: Location of the feature with respect to your
actual path. To input a value for Direction, tap the down
arrow and then tap the desired option (Right or Left).
Press the down arrow to move the cursor to the next
field.
Horz. Distance: Horizontal distance to the feature from
your current position. To input a value for Horz. Distance, press ENTER and type in the new value from the
keyboard or the on-screen keyboard. Then press
ENTER again.
Press the down arrow to move the cursor to the next
field.
Vert. Distance: Vertical distance to the feature from your
current position (“0” if the feature and yourself are at
the same elevation -on a flat area). To input a value for
Vert. Distance, press ENTER and type in the new value
from the keyboard or the on-screen keyboard. Then
press ENTER again.
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Press the down arrow to move the cursor to the next
field.
- Tap OK to return to the Logging screen. This writes the
offset into memory, but you can edit it later if you like
by going through the same process.
Note: Offsets to area features are applied in
MobileMapper Office and not in the receiver.

To operate the grid mapping utility, you will need a
measurement device - anything from a depth sounder
to a ruler, your own sense
of smell or your ability to
make visual observations.
You will also need a compass.
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10.Logging GIS Data on a Preset Grid Feature
The ProMark3's Grid Mapping Utility is an easy way to
automatically set up a series of GPS waypoints to facilitate
the logging of data in an orthogonal grid.This utility
assures that you gather measurements made using field
sensors such as chemical detectors, depth sounders and
magnetometers at an evenly distributed set of locations.
This in turn assures the creation in your GIS of contour
maps with a prescribed density of data and without any
gaps that might force you to return to the field.
The Grid Mapping Utility deals with two different grid concepts: grid features and grid points.
- Grid features are arrays of uniformly spaced waypoints
oriented in rows and columns
- Grid points are navigation features similar to waypoints.
Important Notice: Once you have logged a grid feature in a
job (assuming the selected feature library allows you to do
so), you cannot log any other feature type in the job, not
even another grid feature. Conversely, once you have
logged a point, line or area feature, you cannot log a grid
feature even though the feature library selected for the job
does initially include a grid feature type.
For this reason, you should collect your grid data in specific jobs.

GOTO will not be shown in
the menu list if you press
MENU while the unit displays the Map screen in
cursor mode. In that case,
just press NAV and then
MENU again.

Grid Setup screen

To log GIS data on a preset grid, do the following:
- If you have created a waypoint to help you locate the
first grid point, you can use any of ProMark3's navigation screens to get there. Press MENU and tap GOTO.
Using the Left or Right arrow, make sure Alphabetical is
selected at the bottom of the screen. Then tap User
Waypoint. In the list of waypoints now displayed, tap
the name of the waypoint you want to go to. Again, you
may use any of the ProMark3's navigation screens to
arrive at this waypoint
- Once you arrive at the point of beginning, you should
open up the job file that includes the feature library
describing the grid. If you opened an existing job,
press LOG to take you to the New Feature screen. Then
tap the grid feature type listed on the screen. Usually
the term “grid” is included somewhere in the feature
name so that you can easily recognize this type of feature. Tap the on-screen Log button. The Grid Setup
screen appears on which you can read the definition of
the grid (see opposite)..
When you navigate to the location of the grid, you may
decide to readjust the size and orientation of the grid
based on field observations that you did not foresee
back in the office. For example, you may find that navigating to waypoints with an east-west orientation is
not feasible if the area of interest is situated on a narrow strip of land between two north-south running
streams.
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Spacing
Column

North

Row

(Heading= 0°)
North
Heading=21°

Column

Spacing

Row

In the two examples above:
Columns=8
Rows=6

104

When you change the definition of a grid, ProMark3
always assumes that you are standing in the corner of
the grid from which you can see the grid extend in
front of you and to the right.
The definition of a grid is based on the following four
parameters:
Spacing: Distance between any two consecutive waypoints in any row or column (default: 50 meters or
100 feet, depending on the units used)
Columns: Number of waypoints along the axis facing
you (default: 10; Max.: 100)
Rows: Number of waypoints along the axis perpendicular to the direction you are facing (default: 10;
Max.: 100)
Heading: Direction you face when the grid’s columns
extend in front of you and the rows extend to your
right.
- To change the above parameters, use the up/down
arrows to move the cursor to each of these fields, press
ENTER and edit the field using either keyboard. When
you are done with the definition of a field, press
ENTER. Then press the down/up arrow to access the
next field, etc.
- Record an observation or measurement: Tap OK at the
bottom of the screen. This takes you to the Logging
screen that indicates that you have begun logging data
to the feature and that the receiver is ready to log the
feature's attributes. Remember that you remain stationary for all point features. Describe the feature as
you would any other point feature.

It is also possible to navigate to any grid point (or
any location for that matter) on the Map screen by
tapping over another grid
point. After you record data
at this location, you will
still be prompted to go to
the next grid point .

- Navigate to the next grid point: When you have finished recording the first point feature, tap Done. A
message prompts you to go to the next grid point. Tap
Yes to navigate to the next grid waypoint and record
the next point feature within the grid. This takes you to
the Map screen where you can see your current position marked by the arrow and the next grid waypoint
highlighted with a “crossed box” target symbol. Small
hollow squares indicate the locations of all the unvisited grid waypoints. Small filled squares (“black”
squares) indicate the locations of where you recorded
point feature.
As you begin moving toward the target symbol, you will
see your heading indicated by the direction of the
arrow marking your position. Adjust your movement as
necessary until you are positioned over the target symbol. You may also use any of the other navigation
screens available with your ProMark3. The Arrival
alarm is disabled when navigating to grid points. It is
best to note your distance to the next point and stop
when this value goes to zero. When you arrive at the
next grid point, press the LOG button and you will see
the same Logging screen you used for the earlier measurement or observation.
Each grid point is a geographic coordinate you should
make every effort to occupy so that the data you record
is evenly spaced and complete. However, each grid
point is merely an aid for navigating to the ideal location for an observation or measurement. All the data
you record is ascribed to the position of the ProMark3
receiver and NOT to the grid point.
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If you cannot physically occupy this point, but can
make the necessary visual observation, you should do
so and record an offset estimating the distance and
bearing to the grid point. If you are recording measurements made by an instrument, you should NOT record
an offset but rather try to make a recording as close as
possible to the position.
- When you have occupied as many of the grid points as
you can and recorded the necessary observations and
measurements at each, tap Done at the bottom of the
Logging screen.
- Tap No when ProMark3 asks you to go to the next grid
point.
- Press the LOG button and tap Yes to close the job.
11.Closing the Job
To close a job, from the screen showing the list of attributes,
tap Done then confirm by tapping Yes.
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Revisiting and Updating Existing GPS/GIS
Jobs
You can use ProMark3 not only to position and describe new
GIS features but also to update information gathered previously. This is particularly useful when collecting data on
things that change over time: streetlight bulbs burn out, new
roads are added to housing developments, new crops are
planted, etc.

Job List screen

Screen prompting you to go
to the selected feature
When you know which
attributes must be changed
for a point feature, which
means you don’t really
need to visit the point,
then tap Edit rather than
Goto and change the
attributes directly.

1. General Procedure
Return to the area where the original job was recorded, turn
ProMark3 on and double-tap the Mobile Mapping icon. When it
has calculated a GPS position, follow the procedure below to
update the job or to append more data to it.
- Press the LOG button and tap Open Existing Job.
- Tap the name of the job you want to revisit.
- Unless this screen is already displayed, press NAV repeatedly until the Map screen is displayed. The Map screen
provides a geographical view of the different featutes
present in the job. From this screen, you will now indicate
the first feature you want to revisit. If necessary, press the
IN or OUT button to adjust the scale so you can see this
feature.
- On the Map screen, tap on the feature you want to revisit
first. (The feature name appears in the lower part of the
screen when the cursor is positioned over the feature.)
- When the map cursor is positioned over the feature to be
updated, press ENTER. A new screen is displayed showing
the attribute values currently ascribed to the feature. Note
that the Goto field is highlighted at the bottom of the
screen.
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Map screen showing
straight line to target
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- Tap Goto to ask ProMark3 to guide you to this feature. By
doing this, you will make the selected feature your destination and all the navigation screens will be set to help
you reach that feature. The Map screen will also be automatically displayed showing a straight line connecting
your current destination to the selected feature.
- Walk to the feature according to the navigation instructions provided on the Map screen. You can use other navigation screens if you prefer (see also Navigation Screens
on Navigation Screens on page 126). You will know when
you are close to the feature when the distance to the feature goes to zero or close to zero, or simply because you
can identify it visually. Another nice way of being informed
that you have arrived at the feature is to set the Alarms
option.
- After arriving at the feature, press the LOG key. This takes
you to the Feature Attributes screen.
- Now that you are near the feature and you can see which
of its attributes need to be changed, tap successively each
of these attributes and change them.
- After reviewing the attributes, tap the Done field at the
bottom of the screen. This ends the review of this feature
and displays the Map screen again.
- Follow the same steps described above to revisit and
update the other features present in the job.

2. Repositioning a Point Feature
If a point feature appears to be mislocated on the Map screen,
do the following after you have arrived at the feature:
- Press the LOG key and tap the on-screen Log button. Let
the ProMark3 recompute the point position and then tap
the Done button to close the feature.
Note that only point features can be repositioned. If you
wish to reposition a line or area feature, you should record
a new feature and then delete the old one in MobileMapper Office.
3. Adding More Features and Attributes to the Job
If you want to add more features and descriptions to the existing job, you just have to record them exactly as you record features into a new job.
4. Closing the Job
To close a job, from the screen showing the list of attributes,
tap Done then confirm by tapping Yes.
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Using ProMark3 as a Reference Station
- Mount ProMark3 on a tripod placed over a control point,
turn it on and then double-tap the Mobile Mapping icon.
- Press the MENU key, tap successively Setup and Storage to
choose the media (SD Card or Internal Memory; SD Card
recommended) where to store the reference station data
ProMark3 is going to collect.
- Press the LOG key and then tap Reference Station. The Site
ID screen is now displayed.
- Enter a Site ID (there is a four-character limit) as you
would enter a job name, and then press ENTER.
From now on, ProMark3 will operate as a reference station
until you quit the Mobile Mapping function. It is therefore
important that you not move the receiver or any optional
external antenna until you quit the function.
Before leaving the reference station, press the NAV key
until you can see the Satellite Status screen. Check that
the letter “R” now appears in the upper-right. This means
the receiver is recording reference station data and you
can now proceed with your job.
- After your job is complete, come back to the ProMark3
reference station, press the MENU key and tap Exit. The
ProMark3 exits from the Mobile Mapping function.
- Turn off the unit.

Quitting the Mobile Mapping Function
Press the MENU key and tap Exit. This takes you back to the
ProMark3 workspace screen.
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Office Work with MobileMapper Office
Do not forget to double-tap
the MobileMapping icon or
else no communication will
be possible between
ProMark3 and the PC.

Downloading Field Data from ProMark3
Back in your office, do the following to download your field
data. It is assumed that MobileMapper Office has already
been installed on your PC.
1. On ProMark3:
- Turn on the receiver.
- Double-tap the MobileMapping icon.
- Make sure the ProMark3 Storage option setting will
allow the MobileMapper Transfer utility to access the
desired files. For example, if the files to be downloaded are on the SD Card, make sure SD Card is
selected as the Storage option. To set this information,
press the MENU key then select Setup then Storage.
2. Clip the I/O module as shown opposite.
3. Connect the USB cable between the ProMark3 unit and
your PC (see opposite)..
You can also use a serial cable (RS232) with female DB9
connectors that you connect between your PC and COM1
on ProMark3’s I/O module (see page 4) but the downloading times will be longer than with USB.
The first time you connect ProMark3 to the office PC,
you may be asked to install a USB driver on the PC. This
driver is located on the ProMark3 CD. Once you have
inserted the CD in your CD drive, browse the MobileMapper Office installation folder to select the
“AT91_USBSer.inf” file. Then follow the on-screen
instructions to complete the driver installation.
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It is very important that you
connect the ProMark3 to
the PC BEFORE running
MobileMapper transfer.

4. On the PC:
- From the Windows task bar, select Start>Programs>MobileMapper Office>MobileMapper Transfer.
(Double-click
in the right side of the window if
you want to change to the parent directory and open
another folder on your PC.)
- In the MobileMapper Transfer window, select File>Connect>GPS Device via Cable. The following appears successively in the status bar, at the bottom of the
window:
Looking for GPS device on COMx at xxxx Baud...
Connected to Data Source
Setting Baud rate...
Preparing for listing...
Directory has been listed
The left side of the MobileMapper Transfer window
then lists the files present in the ProMark3.
- Select the files you want to download. If necessary,
hold down the Ctrl key to make a multiple selection.
- Press the F5 key. A Copying file dialog appears during
data transfer.
- After the transfer is complete, close the MobileMapper
Transfer window.
5. On ProMark3, quit the Mobile Mapping function, turn off
the receiver and remove the cable between the PC and
ProMark3.
6. Repeat the previous 5 steps for each of the ProMark3
units involved in the project to download their respective
files to the same project folder on your office computer.
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Downloading Field Data from the Local SD Card
Reader
If your GIS jobs were logged on the SD Card, you can also
download the field data from your local SD card reader if
you’ve got one.
- Extract the SD card from the ProMark3 and insert it into
your local SC card reader.
- From the Windows task bar, select Start>Programs>MobileMapper Office>MobileMapper Transfer.
- (Double-click
in the right side of the window if you
want to change to the parent directory and open your job
folder on the PC.)
- In the MobileMapper Transfer window, select File>Connect>PC drive. As a result, the left side of the window
shows the file structure of your PC.
- On top of the left side of the window, click on the down
arrow and select the letter corresponding to your local SD
card reader (for example “G:”). You can now see the field
data files stored on the SD card.
- In the left side of the window, select the MMJ files you
want to download. If necessary, hold down the Ctrl key to
make a multiple selection.
- Press the F5 key or drag and drop the selected files from
the left to the right side of the window. A Copying file dialog appears during data transfer.
- Close the Download window once the downloading is complete.
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Viewing/Analyzing the Content of a Job
Run MobileMapper Office and then use the File>Open command to open one of the MMJ files you have previously downloaded. As a result, MobileMapper Office shows the content of
this job in the main window. Here is an example of a job open
in MobileMapper Office:

First of all, you can see the list of layers present in this job in
the lower-right corner of the screen. Clear or check the buttons
for the layers you want to see in the Map Display area (the
pane occupying the left part of the window).
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The main purpose of viewing a job in MobileMapper Office is
to get a view of the features that were logged during field operations. If enabled for display, these features are represented
on the Map Display area according to the viewing choices
made for the corresponding layers. You can do more than just
view these features. You can also view the conditions in which
these features were logged. To do that, just click on these features, one after the other in the Map Display area. This opens
a new window in which you can see the properties of these features. In the example below, MobileMapper Office shows the
properties of the selected point being part of an area feature:
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The Feature Properties window provides the following information:
• Feature name and geometry, number of points for lines
and areas only, measurement(s), user-settable Updated
field. Apart from the Updated field, these are non-editable
properties.
The nature of the measurements performed is presented
below:
Length: MobileMapper Office determines the length of
a line feature in the same way used by the receiver: by
estimating the distance between successive points on
the line feature with the assumption that each point is
on a sphere of average Earth radius. The elevations of
the points are not factored into the equation. Thus the
software calculates the spherical distance rather than
the horizontal or slope distance between the successive positions. The length of the line feature is the sum
of all these distances..
Perimeter: MobileMapper Office estimates the perimeter of an area feature in the same way it estimates the
length of line features.
Area of area features: MobileMapper Office determines
areas by estimating the area enclosed within point
locations recorded in the field with the assumption
that each point making up the feature is on a sphere of
average Earth radius. Thus the area is that of a curved,
not flat, feature.
• Observation data (non-editable): date/time, duration of
point logging.
• Current Position for the selected point (non-editable): latitude, longitude, altitude, number of satellites used, PDOP
and correction type.
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The correction type may be one of the following:
- “WAAS”
- “RTCM”
- “Post-processed”
- “Uncorrected” (for autonomous positions)

“Real” feature

d
Direction of
travel along
the feature
Feature offset to the
left by distance d

• Accuracy Estimation for the selected point: horizontal
error, vertical error (non-editable).
• Offset data (editable): direction (for line or area) or bearing (for point), horizontal distance, vertical distance.
This set of properties can be used to artificially move the
receiver’s GPS antenna by a certain distance from the real
position it occupied in the field.
For example, if the receiver was held at 5 feet (1.52 m)
from the ground, you can enter “-1.52” m in the vertical
distance cell to artificially bring the GPS antenna position
down to ground level.
Likewise, you can offset a line or area feature to the right
or left by a certain distance that you enter in the horizontal distance cell. The Left and Right directions for the offset are defined with respect to the direction followed by
the field operator along the feature while logging this feature (see example opposite).
• Attributes (editable): list of attributes and values currently
assigned to these attributes. You can freely change these
values or enter new ones if blank.
There are many other functions that you can use in MobileMapper Office such as creating feature libraries or background maps, importing/exporting GIS data, downloading
reference station data, post-processing jobs, etc. Please refer
to the MobileMapper Office User Manual for more information.
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Uploading a Vector Background Map
Vector background maps are generated from DXF, SHP or MIF
files imported in MobileMapper Office’s Map Editor.
Note that raster background maps CANNOT be uploaded to
ProMark3 in its current version.
It is all or part of the background map attached to MobileMapper Office’s Map Display area that can be uploaded.
The background map is output as an IMI file. The IMI file can
be directly uploaded to the ProMark3, or copied to the SD
card inserted in the local SD card reader, or stored on the PC
hard disk. In all cases, a connection to the ProMark3 is a prerequisite to the upload sequence.
Assuming the ProMark3 unit has been connected to the PC via
the USB or RS232 cable, it has been turned on, you have double-tapped the Mobile Mapping icon and you have selected the
storage medium on which to upload the map, do the following
on PC side:
- Launch MobileMapper Office.
To attach the desired vector map to the Map Display area:
- Click
- On the Vector Maps tab, select this map from the left-hand
list and then click the Attach Map button.
- Click OK to close the window.
If you want to upload only a region of the background map:
- Click
- Drag a rectangle around the desired region and then
release the mouse button.
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The limits of the region are now represented with a rectangle. You can still resize or reshape the rectangle by dragging its control points (corner and mid-side points). You
can also move the whole rectangle by dragging the mouse
cursor from inside the rectangle.
- When the location and size of the region is okay, click outside of this region.The region is now defined and its limits
are represented by a thick green line.
NOTE: To delete the region and start over, resume the
above three steps.
Start the upload procedure as such by selecting File>Upload to
GPS>Background Map. MobileMapper Office tests the connection to the ProMark3 (the software needs to know which type
of receiver the map is intended for). Once the data link is established, you can make one of the following three choices:
• Upload to GPS Unit if you want to upload the map
directly to the ProMark3.
• Upload to SD Card Reader if you simply want to copy
the background map to the SD card inserted in the
local SD Card Reader (you will use that SD card later
in a ProMark3).
• Or Store on Hard Drive if you just want to create now
the IMI file on your hard disk so that later you can
copy it to an SD card using the local SD card reader.
1. If you select Upload to GPS Unit, then:
• Click Next >
• After the GPS unit has been detected on the USB or
RS232 port, click Next > again.
• MobileMapper Office indicates the size of the map
file and the remaining memory space on ProMark3.
Click Finish.

119

• If the map filename uses more than 8 characters,
MobileMapper Office will warn you that this name
will be truncated. Keep the truncated name or type a
different name and then click OK.
• Wait until the uploading messages on the PC and
ProMark3 disappear.
• When the upload procedure is complete, press
MENU on the ProMark3, tap Setup and then Select
Map.
• Tap in the Detail Map field and then select the name
of the file you have just uploaded
• Tap Save. ProMark3 starts loading the new map.
After a while, the Map screen is displayed.
• Use the IN, OUT and scrolling buttons to get a full
view of the new map on the Map screen.
2. If you select Upload to SD Card Reader, then:
• Click Next >.
• Select the drive letter corresponding to the local SD
card reader (e.g. “G:”)
• Click Next > again. MobileMapper Office indicates
the size of the map vs. the remaining memory space
on the SD card and the name of the background
map file.
• Click Finish if you agree. The background map file is
transferred to the SD card.
3. If you select Store on Hard Drive:
• Click Next >. MobileMapper Office indicates the size
of the map vs. the remaining memory space on the
hard disk, the folder where the file will be saved and
the name of the background map file.
• Click Finish if you agree. The background map file is
saved on the hard disk.
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Uploading Jobs and Waypoints to ProMark3
To create a waypoint
in a job:
Click on
in the
MobileMapper Office toolbar and then click where to
create the waypoint on the
Map Display area. If necessary, adjust its coordinates,
icon and name in the edit
box on the right.
For more detail, please
refer to the Using the Waypoint/Route Editor Chapter
in the MobileMapper Office
User Manual.

Jobs and waypoints associated with jobs are uploaded through
the same procedure.
The way waypoints are uploaded and made available on the
ProMark3 depends on whether the uploaded job is “empty”
(i.e. there is no GIS data in it, just waypoints) or not:
- If the job is “empty”, the uploaded waypoints will replace
the list of existing waypoints stored in the ProMark3. Prior
to uploading, a message will warn you that the waypoints
currently stored in ProMark3 will be deleted.
- If the job is not “empty” (i.e. it contains GIS data), waypoints are uploaded as a separate MMW file associated
with the MMJ job file. On ProMark3, these waypoints will
be visible only when you open the corresponding job.
These waypoints will add up to the list of existing waypoints.
Assuming the ProMark3 unit is connected to the PC via the
USB or RS232 cable, it has been turned on and you have double-tapped the Mobile Mapping icon, do the following on PC
side:
- Launch MobileMapper Office.
- Open the MMJ job file you want to upload
- Click
to read the list of waypoints associated with the
job. If you change the list, save the job before continuing.
- Select File>Upload to GPS>Job.
• If the job is “empty”, a message will warn you that all
waypoints currently stored in the ProMark3 will be lost
if you continue. Click Yes if you agree and then wait
until the upload procedure is complete.
• If the job is not “empty”, MobileMapper Office will
successively upload the MMJ file and then the MMW
file.
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Uploading Jobs and Waypoints to the Local SD
Card Reader
If you are using the SD card in the field rather than the
ProMark3’s internal memory, you can also copy your MMJ and
MMW files to the SD card using the MobileMapper Transfer
utility and your local SD card reader.
- Extract the SD card from the ProMark3 and insert it into
your local SC card reader.
- From the Windows task bar, select Start>Programs>MobileMapper Office>MobileMapper Transfer.
- (Double-click
in the right side of the window to
access the folder containing the MMJ and MMW files you
want to upload.)
- In the MobileMapper Transfer window, select File>Connect>PC drive. As a result, the left side of the window
shows the file structure of your PC.
- On top of the left side of the window, click on the down
arrow and select the letter corresponding to your local SD
card reader (for example “G:”). You can now see the field
data files stored on the SD card.
- In the right side of the window, select the MMJ and MMW
files you want to upload. If necessary, hold down the Ctrl
key to make a multiple selection.
- Press the F5 key or drag and drop the selected files from
the right to the left side of the window. A Copying file dialog appears during data transfer.
- Close the MobileMapper Transfer window once the uploading is complete.
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Exporting to GIS
- Open the job containing the data you want to export to
your GIS.
- Run the File>Export function, select the format in which to
export the data, name the export file and click Export.
For more information please refer to the MobileMapper Office
User Manual (also provided on the ProMark3 CD).
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5. Accuracy
Autonomous GPS, SBAS & DGPS Modes

To achieve the best accuracy, it is important to hold
the receiver at an angle of
45 degrees from horizontal. This allows the internal
antenna to pick up signals
from the GPS, WAAS and
EGNOS satellites. This is
especially true when
recording data for post-processing.
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ProMark3 provides autonomous 3-meter accuracy all around
the globe assuming the receiver is tracking five GPS satellites
and the PDOP < 4 (which is almost all the time).
ProMark3 is also capable of providing 50- to 70-cm horizontal
accuracy using real-time differential corrections from its builtin SBAS receiver. You must be in North America to make use
of the free WAAS signals broadcast by the US Federal Aviation
Administration. You must be in Europe to make use of the free
EGNOS signal broadcast by the European Union. If you are using the Mobile Mapping function and SBAS signals are received, a “W” will appear on all logging screens (after the
number of received satellites; see page 125).
In addition to SBAS, ProMark3 can apply real-time differential corrections (DGPS) from land-based systems such as
Coast Guards beacons or your own privately broadcast RTCM
Type 1 or Type 9 corrections. Just use the serial cable to connect your ProMark3 to a differential correction receiver. A
"DGPS.." will appear on the ProMark3's Position screen when
the receiver detects RTCM input.
The accuracy with land-based systems is approximately the
same as with SBAS. However, it is possible to improve accuracy by one or two decimeters if you broadcast your own RTCM
corrections while keeping the distance between the broadcasting reference receiver and the rover receiver less than 10
km (3 miles).
If you average positions for a point feature for a few minutes,
even better accuracy is possible.

ProMark3 may warn you if the PDOP, and therefore the accuracy, of your positions has dropped below the level you selected during Setup (see page 157, the PDOP alarm option). If
you see this warning you may press the ESC button and continue logging.
However, if you are running a kinematic survey or recording
line or area features, you might want to return to the field
when the GPS satellites are in a better configuration overhead
(the constellation changes slowly but constantly).
And if you are running a static survey or recording a point feature, you should strongly consider moving to another location
with better satellite reception and recording an offset (distance and bearing) to the feature.

Quality Indicators

GPS quality indicators

Tracking 3 satellites will in
principle allow you to calculate a 2D position (lat/
lon) using the last altitude
recorded by the receiver.
You need to track at least 4
satellites to get a 3D position (lat/lon/altitude). To
achieve the specified accuracies for ProMark3, you
will need to track 5 or more
satellites.

On the Survey Status screen in Surveying or at the bottom of
each logging screen in Mobile Mapping, you can see two numbers that give you a good indication of how accurate the
ProMark3 unit should be.
The first is the number of satellites that the receiver is tracking. In Mobile Mapping, a “W” will appear after the number
of satellites if SBAS is used. The presence of this letter is indicative of an even better accuracy level.
The second number is the Positional Dilution of Precision
(PDOP), which is an estimate of accuracy that the receiver
constantly calculates using the geometry of satellites in the
sky. The more satellites that are being tracked and the more
evenly they are distributed around the sky, the better the accuracy. PDOP values less than 4 or 5 are good. If the PDOP
value is over 5, you should consider moving to an area with a
clearer view of the sky and recording features with offsets.
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6. Navigation
ProMark3 offers very helpful navigation functions that you can
use while performing your field operations, whether Surveying
or Mobile Mapping.
The present chapter tells you how to use the navigation
screens, how to create waypoints and how to work with the
GOTO and Routes functions.

Navigation Screens
You will be able to view the
different navigation
screens only after launching the Surveying or
MobileMapping application.
The Map screen has two
modes: Position and Cursor. Using the stylus, tap
anywhere on the map, or
press any arrow key, to
select Cursor mode. Press
ESC to return to Position
mode.
When a Position screen is
displayed, press the Left or
Right arrow key to display
the other. Press this key
again to return to the previous screen.
Except for the Satellite
Status screen, all navigation screens can be customized.
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ProMark3 ofMap Screen
fers 7 different
Press NAV
navigation
screens to help
Satellite Status Screen
Compass Screen
you locate yourPress NAV
self or navigate
Large Data Screen
to waypoints or Speedometer Screen
etc.
GIS features in
an existing job.
Data Screen
Position Screen 1
From any disPosition Screen 2
played screen,
Road Screen
simply press
the NAV button to access the last-used navigation screen. To
display the next navigation screen, press NAV again. The sequence of navigation screens is as shown above. It can be
scrolled in the reverse direction by pressing ESC once any of
these navigation screens is displayed.
You may find that you do not regularly use all of these screens.
To make it faster to move among those screens that you do
use, you may turn off individual navigation screens (except
the Map and Satellite Status screens) by pressing the MENU
button, selecting the Setup option and then the Nav Screens
option.

Select either On or Off for each screen until you see the Setup
menu once more. Note that you must cycle through all the
screens in order to put your selections into effect.
The following is a description of each of the navigation
screens.

Map Screen

Map screen in Position
mode

Map screen in Cursor mode

The Map screen shows a map of the area surrounding your current location. Use the IN and OUT buttons to adjust the scale.
The Map screen is always in the Position mode when you access this screen. In this mode, your present position is indicated by the large arrow icon in the center of the display. If
you are moving, the arrow will point in the direction that you
are heading. At the bottom of the screen is the scale for the
map displayed and two data fields that can be customized, or
turned off, depending upon your needs.
The present position icon will change to an hourglass when
the ProMark3 is unable to compute a position fix due to poor
signal reception.
Tap anywhere on the Map screen or press any of the arrow keys
to switch to the Cursor mode. In this mode, you are provided
with a cross hair cursor that can be moved using the stylus
(you tap directly where you would like the cursor to be) or, for
a step-by-step move, by using the arrow keys.
At the bottom of the display is the information for the position
of the cursor relative to your present position (heading and
distance). Also any points of interest or GIS features that the
cursor is over will be shown.
To return to the Position mode, press ESC. The cursor will disappear and the present position icon will appear centered on
the map.
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Compass Screen

Compass screen
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The two data fields on top are customizable. The lower portion
of the Compass screen displays your heading in a graphical
manner.
The Compass screen contains the following information, from
top to bottom:
- In the title bar: destination name if you are using the Goto
function
- Data Fields: customizable data fields (see Customize
option on page 162). Some of the data displayed requires
you to be moving to be computed. Invalid data is indicated by dashes.
- Icon representing destination: Displayed outside the compass when you are using the Goto function. This provides
you with the direction you need to head to arrive at the
destination. When you are on course and heading straight
for the destination, the destination icon will be lined up
with the heading marker
- Compass/Heading marker: Using the compass and the
heading marker, you can view your heading information in
a familiar manner. Note that you need to be moving for
this data to be valid.

Large Data Screen
The Large Data screen is similar to the Compass screen but
here the compass has been removed to allow for large display
of the navigation data. This screen is ideal for when you have
your unit mounted on the dashboard of a vehicle. Even from a
distance the customizable information can be read with ease.
The Large Data screen contains the following information,
from top to bottom:
- In the title bar: destination name if you are using the Goto
function
- Data Fields: customizable data fields (see Customize
option on page 162). Some of the data displayed requires
you to be moving to be computed. Invalid data is indicated by dashes.

Large Data screen
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Position Screens

Position screens 1 & 2

To switch from a screen to
the other, just press the
Left or Right arrow key.
The same data as on Position screen 1 is displayed
on Position screen 2
except that the lower part
of the screen, containing
the two data fields and the
trip odometer field, is
replaced with the current
position’s coordinates
expressed in the chosen
secondary coordinate system and map datum.
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Position screens #1 and #2 display your present position using the coordinate systems that you have selected (see how to
select these systems in the two sections Coord System on
page 154 and Map Datum on page 156.
This screen shows all of the basic position, time and satellite
information. Additionally, on Position screen #1, current navigation information is shown in the bottom half of the screen.
For the sake of comparison, Position screen #2 provides the
coordinates of your present position both in the selected primary coordinate system and map datum, and in the selected
secondary coordinate system and map datum.
Position screen #1 contains the following information, from
top to bottom:
- Coordinates and elevation of your current position: Displays your current position in the chosen coordinate system. Also displays the elevation of the current position. If
ProMark3 is not computing position fixes, the last computed position is displayed.
GPS Satellite Status: Provides information on the current status of the GPS receiver section of the ProMark3 (see table below).

Message

Description

Searching - 1st sat

Searching for 1st satellite

Searching - 2nd sat

1st satellite found; searching for 2nd satellite

Searching - 3rd sat

2 satellites are being tracked; searching for a 3rd

Searching - 4th sat

3 satellites are being tracked; searching for a 4th

Collecting Data

All satellites needed for position fix are being tracked
and position is being computed

Averaging

ProMark3 is computing fixes; speed is near 0.0 and so
position is being averaged

WAAS Averag

ProMark3 is computing fixes using SBAS; speed is near
0.0 and so position is being averaged

EPE xxx.

Estimated Position Error. ProMark3 is computing fixes
while moving

DGPS
DGPS Averag

Computed fixes are being differentially corrected using
RTCM corrections (“DGPS Averaging” when speed near
0.0.)

- Data Fields: customizable data fields (see Customize
option on page 162). Some of the data displayed requires
you to be moving to be computed. Invalid data is indicated by dashes.
- Trip Odometer: The odometer performs like the odometer
in your car. It can be reset through the MENU button.
To customize the Position screens, use the functions described below. The first of these context-sensitive functions is
prompted when you press the MENU button while a Position
screen is displayed. Some of these functions also exist in the
Setup menu.
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Road Screen

Road screen
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The Road screen presents your route as if you were travelling
on a road. When you need to make a turn, the road will graphically display the turn and the direction. Waypoint and destination icons will be displayed relative to your position as they
come into view. Above the road is a compass that displays your
heading and above that are four customizable data fields.
The Road screen contains the following information, from top
to bottom:
- In the title bar: destination name if you are using the Goto
function
- Data Fields: customizable data fields (see Customize
option on page 162). Some of the data displayed requires
you to be moving to be computed. Invalid data is indicated by dashes.
- Compass: Displays your heading in a familiar compass format.
- Road: This graphically displays the route (Goto) that is
active. As you move left or right of your intended track, the
road will move on the display indicating which way you
need to steer to get back on track. Ideally, the road would
be centered on the display. Also, you will see upcoming
turns in advance allowing you to make necessary preparations.
- Scale indicator: Use Zoom In/Out to change the scale.

Data Screen
When you need to see a lot of information in one place then
you will appreciate the Data screen. The Data screen provides
you with six data fields and an active compass that is the same
as the one used on the road screen. You have the option of
customizing this screen by selecting what data is displayed in
the upper six fields. The lower portion of the screen is occupied by a compass providing your heading.
The Data screen contains the following information, from top
to bottom:
- In the title bar: destination name if you are using the Goto
function
- Data Fields: customizable data fields (see Customize
option on page 162). Some of the data displayed requires
you to be moving to be computed. Invalid data is indicated by dashes.
- Compass: Displays your heading in a familiar compass format.
Data screen
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Speedometer Screen

Speedometer screen
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The Speedometer screen displays your speed in a familiar
graphical format. There are four additional data fields at the
top of the display that can be customized to display the data
that you need. The bottom of the screen contains a trip odometer that will record the distance travelled since the last time
the odometer was reset.
The Speedometer screen contains the following information,
from top to bottom:
- In the title bar: destination name if you are using the Goto
function
- Data Fields: customizable data fields (see Customize
option on page 162). Some of the data displayed requires
you to be moving to be computed. Invalid data is indicated by dashes.
- Speedometer: Displays your speed using a familiar speedometer display. The scale of the speedometer is not
adjustable but will change dynamically to best display
your speed.
- Trip Odometer: The odometer performs like the odometer
in your car. It can be reset through the MENU button.

Satellite Status Screen
Although the Satellite Status screen is part of the navigation
screen sequence, it is not actually a navigation screen.
When ProMark3 is computing your position, an additional information appears in the right-upper corner with two possible
values: 3D or 2D. 3D means the computed position is 3-dimensional (elevation computed). In 2D (2-dimensional), elevation is not computed. ProMark3 assumes that the last
computed or entered elevation is the elevation for all computed positions.
See also page 30.
Satellite Status screen
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GOTO Function
Purpose
You use the GOTO function to ask ProMark3 to guide you from
your current position to a destination point. You will be able
to use this function only after launching the Surveying or MobileMapping application.
After you will have specified which destination point to go to,
you will select your favorite navigation screen. You will then be
able to read the information computed by ProMark3 to help
you reach the destination.

Destination Point Types
ProMark3 can guide you to:
- Any point of interest (POI) pre-loaded in ProMark3.
- Any waypoint created using the Mark function. This type
of point is listed as a “User Waypoint” category in the POI
(Point Of Interest) database.
- The active background map (as set in the DetailMap field
on the MENU>Setup>Select Map screen), which appears on
top of the POI list (see oposite).
- Any feature logged in the open GIS job which you will
select graphically on the Map screen.
List of POI categories
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Selecting a POI as the Destination Point

GOTO will not be shown in
the menu list if you press
MENU while the unit displays the Map screen in
cursor mode. In that case,
just press NAV and then
MENU again.

Press MENU and tap GOTO. The possible categories of POIs
are now listed on the screen. Use the Up/Down arrow keys to
highlight the category the destination point belongs to.
Before pressing ENTER to list all the points stored in this category, choose how you want these points to be listed by setting
the Find By field. Press the left/right arrow to set this field. Two
values are possible in this field:
- Alphabetical: Points will be listed in alphabetical order.
ProMark3 will then help you find the desired point through
one of the following two methods: Keyboard Search and
Alphabetic Scroll.
Keyboard Search: Before displaying the list of points in
alphabetical order, ProMark3 displays a keyboard that you
can use to enter the first few characters of the point you
are looking for. When you press ENTER, you are taken to
the alphabetical list with the point you began typing at the
top of the display. Anytime you are viewing the list of
points, you can re-access the keyboard by pressing ESC.
Alphabetic Scroll: When the alphabetical list is displayed,
you can use the IN and OUT buttons to step up or down
the alphabet. If you were viewing points beginning with
the letter “A”, pressing OUT would take you to the first
waypoint beginning with “B”, and then “C” and so forth.
Pressing IN does the same function but only in reverse.
- Nearest To: Only the 20 points from this category the closest to either your position or another POI will be listed.
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When these 20 points are listed, ProMark3 indicates the bearing and distance to your current position from the first point
in the list. You can change the point from which the nearest
points are found. With the Nearest To field now highlighted,
press ENTER and scroll to the category where this new point
can be found. Select a new point and press ENTER. If you
have already pressed the arrow keys and one of the nearest
points in the list is highlighted, use the ESC button to scroll
back to the Nearest To field.

Selecting a GIS Feature as the Destination Point

Selecting a GIS feature as
the destination
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Assuming a GIS job is open and contains already logged features:
- Press NAV until the Map screen is displayed.
- Using the IN and OUT buttons, adjust the scale in such a
way that you can see the feature you want to go to.
- Using the stylus, tap this feature. You know that the cursor
is positioned over the feature when the “Cursor” indication at the bottom of the screen is replaced with the name
of that feature. You may use the arrow keys to refine the
position of the cursor over the feature.
- Press ENTER. A new screen appears giving the current
description of the feature. At the bottom of the screen,
simply tap Goto to enable the Goto function with this feature as your destination. Then select your favorite navigation screen, using the NAV button, and navigate to this
feature.

Saving Your Current Position as a Waypoint

Mark screen

Saving your current position as a waypoint is very easy and can
be done from within the Survey or GIS function.
From any screen, just press the MENU button, and select the
Mark option. The Mark screen appears. This screen provides
the description of the waypoint you are about to save.
You can accept all the defaults by simply pressing ENTER
(Save field already highlighted).
You can also edit the Icon, Name and Message fields using the
arrow keys to access these fields. Obviously you should keep
the Location and Elevation fields unchanged as they contain
the coordinates of your current location.
Waypoints recorded using the receiver's Mark feature are not
exportable by MobileMapper Office. If you wish to record waypoints in the field and export them to GIS formats, you should
use MobileMapper Office's Feature Library Editor to create a
"Waypoint" feature type. You can then log a "waypoint" as a
point feature while recording a job file.

Editing/Deleting a User Waypoint

Select Item screen

You can edit/delete a waypoint from the Map screen:
- Press NAV until the Map screen is displayed
- Use the IN or OUT button, or move the cursor so that the
waypoint you want to edit or delete is visible on the screen
- Position the cursor over that waypoint. The name of the
waypoint then appears at the bottom of the screen.
- Press ENTER. This opens the Select Item screen on which
ProMark3 lists the names of the items present in the
vicinity.
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Select Item screen

- Tap the waypoint you want to edit/delete. This opens the
User Waypoint screen on which you can see the definition
of the waypoint (coordinates+comments). At the bottom of
the screen are three command fields that you can use for
the following tasks:
Edit (default choice): Select this field if you want to edit
the definition of the waypoint. The following parameters
can be changed: icon, name, coordinates, elevation and
comment.
Goto: Select this field if you want ProMark3 to guide you
to this waypoint
Del: Select this field if you want to delete the waypoint.
ProMark3 will then ask you to confirm that you really want
to delete the selected waypoint.

Clearing the GOTO function
To ask ProMark3 to stop guiding you to a destination while the
Map screen is displayed in position mode:
- Press MENU
- Tap GOTO. A message appears asking you to confirm that
you would like ProMark3 to stop guiding you to this point.
- Tap Yes
- Press ESC to return to the Map screen.
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Routes
You will be able to use this function only after launching the
Surveying or MobileMapping application.
As explained below, ProMark3 can handle two types of routes:
GOTO route and multi-leg route.

GOTO Route

A GOTO route is a one-leg
route whose two ends are
your current position and
the chosen destination
point.

This in fact a route that you define when:
- You select a waypoint on the Map screen, you press
ENTER twice to display the properties of this waypoint,
and you tap GOTO to enable the Goto function to this waypoint . The same can be done to choose a POI or a GIS
feature as the destination point.
- You use the GOTO option after pressing MENU and you
choose a POI or waypoint as the destination point.
GOTO routes are not saved in memory. When you turn your
ProMark3 off and then back on, the GOTO route is gone. You
need to create a new GOTO route if you intend on completing
the route.

Multi-leg Route
WPT6
WPT5
WPT4
WPT3
WPT2

A multi-leg route consists of several waypoints or POIs that
you should reach one after the other. The segment between
any two consecutive waypoints or POIs is called a “leg.” Unlike GOTO routes, multi-leg routes can be stored in memory.
The backtrack route also belongs to the category of multi-leg
routes (see page 143).

WPT1
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Create Route screen

Route List screen
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1. Creating a Multi-leg Route
- Press MENU and tap Routes. The Route List screen is now
displayed.
- Tap the first Empty route in the list.
- Press MENU and tap Create New Rte. The Create Route
screen is now displayed and the first line on this screen is
highlighted.
- Press MENU and tap Insert WPT. The Insert WPT screen is
now displayed.
- Press the Left or Right arrow to select Alphabetical at the
bottom of the screen.
- Tap User Waypoint
- Browse the list of available waypoints and tap the name of
the waypoint you want to define as the first waypoint in
the route. You are then prompted to define the second
waypoint in the route.
- Resume the previous 4 steps to define the next waypoints
in the route.
- When the last point of the route is defined, tap the Save
Route button on the Create Route screen.
2. Activating/deactivating a Multi-Leg Route
- Press MENU and tap Routes.
- In the Route List screen now displayed, tap the route you
want to activate.
- Press MENU and tap Activate Route. ProMark3 comes back
to the Route List screen where the activated route now
appears in bold characters. Press NAV to navigate along
this route.
To deactivate this route:
- Press MENU and tap Routes,
- Tap the activated route in the list
- Press MENU and tap Deactivate Route. The route is now
deactivated.

3. Asking ProMark3 to Retrace your Steps
If the Track Mode is active (see page 151), the ProMark3 automatically creates and stores hidden points into memory as
you move. This series of points is called the “track” or “track
history”. To retrace your steps, do the following:
- Press MENU and tap Routes.
- Select Backtrack.
- Press MENU again and tap Activate Backtrk. A message
appears warning you that the Track History Logging is now
disabled.
- Tap OK and press NAV to return to the Map screen. Now
let ProMark3 guide you along the existing track, using the
track’s hidden points as navigation waypoints, to go back
to the track’s start point.
4.
-

Creating a Route from the Track History
Press MENU and tap Routes.
Select Backtrack.
Press MENU again and tap Save Trk to Rte. ProMark3 converts the track’s hidden points into User Waypoints. The
new route then appears on the Route List screen. It consists of waypoints that are numbered “TxxPyy” (where xx
is the route number in the list and yy is the order number
of the waypoint in the route).
For example the created route could be named “T01P01
.. T01P07”.
Note that the the route is a copy of the track and not the
backtrack.
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5. Other Functions Tied to Routes
You can also do the following on the highlighted route using
the functions available from the MENU button (see also diagram on page 148):
- Viewing the route on the Map screen by pressing MENU
and tapping Map View Route. The Map screen then appears
showing the route. Press ESC to come back to the Route
List screen.
- Editing the route by pressing MENU and tapping View/Edit
Route. From the View/Edit screen you can then press the
MENU button to access options allowing you to insert,
delete, replace the highlighted waypoint and then to save
the changes made to the route.
- Reversing the route, i.e. reversing the direction of travel
along the route, by pressiong MENU and tapping Reverse
Route. This instantly reverses the route. Note that the first
and last waypoints in the route name have been swapped.
- Deleting the route by pressing MENU and tapping Delete
Route. A message will appear asking you to confirm this
operation.
- If a route has been activated, selecting the leg you want to
follow by pressing MENU and tapping Select Leg. The
screen then shows the list of points making up the route.
Tap the waypoint you want to navigate to. A warning message will appear asking you to confirm the leg change.
After choosing Yes or No, press ESC twice to return to the
navigation screen.
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7. MENU key
The MENU key is inactive
until you double-tap the
Survey or Mobile Mapping
icon.

The diagram below shows the available functions when pressing MENU. When you select the Setup option in the menu list,
another menu is displayed containing a number of options, as
shown in the diagram below.

(Not available if Map
screen displayed in
cursor mode)
(Available only when a
customizable navigation
screen is displayed)

File Manager
Mark
GOTO
Routes
Setup
Customize
About...
Exit

Storage
Receiver ID
Select Map
Map Setup
Nav Screens
Coord System
Map Datum
Time Format
Units
Alarms
North Reference
Beeper

(Survey only)

Reset Trip

Clear Memory
Simulate
Language

All the options available from the Menu screen are described
below.

File Manager
This option allows you to list the files stored in the internal
memory or SD card, depending on the choice you have made
through Setup and Storage.
A sign is placed before each filename. The meaning of this
sign is as follows:
+ Indicates that the file has not yet been downloaded from
the handheld
- Indicates that the file has been downloaded from the
handheld.
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The name, last modification date and size of the selected file
is shown at the bottom of the screen. Only the following file
types are listed:
- R*.*
- *.MMJ
- *.MMF
- *.IMI
You can delete the selected file or all the files by tapping respectively Delete or Delete All and then Yes to confirm.
(Delete All does not delete waypoints, track, routes and user
settings but only the listed files, as opposed to Clear All in Clear
Memory which deletes all waypoints, track and routes but does
not impact user files; see page 160.)
When the internal memory is selected for storage, you can
copy files to the SD Card you have previously inserted in the
unit. Tap the Copy button and then one of the following options:
- All Files: All listed files are copied to the SD Card
- Selected File: Only the highlighted file is copied to the
SD Card
- New Files: Only the files with filenames preceded by
“+” are copied to the SD Card.

Mark
This option allows you to quickly create a new waypoint whose
default coordinates will be those of your current location.
A typical use of this option is when you are located at a new
point of interest and you wish to log its position.
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When you select Mark in the menu list, ProMark3 displays the
Mark screen with the following default values:
- Default icon in the Icon field
- “WPTxxx” as waypoint name in the Name field. “xxx” is a
number that ProMark3 automatically increments as you
create new waypoints
- Coordinates of your current location in the Location and
Elevation fields
If you agree with all these parameters, and as the Save field is
already selected at the bottom of the screen, you just have to
press ENTER to create the new waypoint. This is the fastest
procedure to create a new waypoint.
On the other hand, if you have to change any of these parameters or add a comment in the Message field, then you have
first to edit the corresponding fields before selecting the Save
field and pressing ENTER
The Route button gives direct access to the Route List screen
where you can insert the newly created waypoint into a new or
existing route.
If you would like to add more description or if you would like
to export a waypoint to your GIS, use a feature library that includes a point feature called “Waypoint” and whatever level of
attribution that you need. Then, when you want to record a
waypoint, you can select the Waypoint feature type from the
feature library and record a fully describable and exportable
point feature.

GOTO
This option is discussed in detail on page 136.
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Routes
This option is discussed in detail on page 141. The MENU
button gives access to a list of specific options when the
Routes option is enabled. This is summarized in the diagram
below.
Insert WPT
Delete WPT
Replace WPT
Save Route

From View/Edit
Route screen

Activate Route
View/Edit Route
Reverse Route
Delete Route
Save Trk to Rte
Map View Route

From Route list
screen, route
highlighted, not
activated
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Deactivate
Advance Leg
Save Trk to Rte

Activate Backtrk
Save Trk to Rte

From Route list
screen, backtrack
route highlighted,
activated

From Route list
screen, backtrack
route highlighted,
not activated

Deactivate Route
Select Leg
View/Edit Route
Reverse Route
Delete Route
Save Trk to Rte
Map View Route

Create New Rte
Save Trk to Rte

From Route List
screen, route highlighted and activated

From Route List
screen, empty
route highlighted

Setup Menu
Storage
This option allows you to choose the media to which
ProMark3 will save the data collected in the field. There
are two possible choices:
• Internal Memory
• SD Card
In surveying, your choice of storage media is reminded at
the bottom of the logging screen:
• “SD Card” is displayed inside the lower-right rectangle
if you chose the SD Card
• Nothing is mentioned in that rectangle if you chose
the internal memory.

Receiver ID
(Surveying only)
This option provides you with the ability to enter the 4character receiver ID which is used in naming the raw data
files. Each raw data file from this receiver will include this
4-character receiver ID.
The receiver ID must be unique among all receivers used
together in a survey. Otherwise, raw data files will be given
the same name, causing problems when the data is downloaded to the same location on the office computer for
processing.
Valid characters are 0-9 and A-Z.
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Select Map
This option is mainly used to choose the background map
(Detail Map) that ProMark3 will display on the Map
screen. The following parameters can be set on the
Change Map screen:
- Basemap: Only the Default Map option can be selected
in this field. The default map – a worldwide map – is
always present in ProMark3.
- Detail Map: Select the desired background map from
the list attached to this field. If you did not upload a
background map to ProMark3, then only the Empty
option can be selected in this field. The extent of a
detail map is usually limited to the extent of the area
you are working in.
Background maps are IMI files downloaded into the
unit using GNSS Solutions (see Uploading a Vector
Background Map to ProMark3 on page 84) or
MobileMapper Office (see Uploading a Vector Background Map on page 118). Only one background map
can be displayed at a time. This map naturally combines with the basemap. The list of detail maps shows
the IMI files stored in the internal memory and those
stored on the SD card whatever the storage setting.
After choosing the desired options for these parameters,
tap Save.
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Map Setup

Map Setup screen,
Format tab

Auto

Auto Detailed

Fixed Rate

This option allows you to set the viewing options for the
Map screen.
On the Format tab, you can set the following parameters:
- Orientation: You can change how the map is orientated
on the screen to either North Up, Course Up or Track
Up. Default is North Up.
- Detail: Use this field to set the detail for both the
basemap and the detail map. This field can be set to
highest, high, medium, low or lowest. This changes
the zoom level that different map objects (cities, highways, labels, etc.) are displayed. If you have set a
zoom level and the display is too cluttered, set the
map detail to a lower level; conversely set it to a higher
level to view more detail.
- Track Mode: Allows you to set how often the ProMark3
stores track points:
• Off: Stops the ProMark3 from saving any new track
points.
• Auto: The ProMark3 uses a method for track point
storage that maximizes memory. Using Auto, you will
see more points on and near turns and less points on
straight stretches of the map.
• Auto Detailed: Same as Auto but with more track
points on and near turns.
• 2.0 km, 1.0 km,..., 0.05 km, 0.01 km: Fixed time intervals for track point storage.
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Map Setup screen,
Display tab
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Please note that the Track Mode will be automatically
set to Off when you start logging a new feature in the
open GIS job (using the Mobile Mapping application).
This is to avoid confusion on the Map screen between
features and track points. The Track Mode will be automatically restored with its initial settings when you
close the GIS job.
- Primary Usage: ProMark3 can be set to either Land or
Marine usage. When in Land (default), the map displays land areas in white and water areas in blue. For
marine applications it may be desirable to reverse the
display, showing water as white and land as blue. This
will make reading some of the data information on the
water easier.
From the Display tab, you can customize the Map screen
by specifying the items that ProMark3 should display on
the map:
- Show Map Info: Use this option to show or hide the two
data fields displayed at the bottom of the Map screen.
To customize these fields, see Customize on page 162.
- Waypoints (default: checked)
- Track Lines (lines connecting track points if Track Mode
different from Off; see page 151)
- Pos-Dest Line (line connecting current position to destination)
- Depart-Dest Line (line connecting initial position to destination)

Check the items you want to show and clear those you
want to hide. You can also check or clear all these items in
a single operation by respectively selecting Mark All or Clear
All just above these items.
Press ESC or NAV to quit the Map Setup screen.

Nav Screens
This option allows you to remove the navigation screens
that you do not need from the navigation screen sequence
that you scroll by pressing NAV repeatedly (see page 126).
When selecting this option, you are asked to turn off or on
each of the available navigation screens. Tap “Off” for all
these screens that you are not currently using. Note that
the Map screen cannot be turned off. You must cycle
through all the screens in order to save any changes to the
On/Off status of any screen.
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Coord System
This option allows you to define a primary coordinate system, and also a secondary coordinate system if you need
one.
By defining a coordinate system, you tell ProMark3 how
the calculated coordinates should be expressed. For example, if you choose Lat/Lon, all coordinates will be expressed
as angles (latitudes and longitudes) and if you choose UTM
or any other system, coordinates will all be distances
(Northings and Eastings) from the chosen origin.
When you select the Coord System option from the Setup
menu, ProMark3 asks you to specify which system you
want to define (primary or secondary). Tap one. In the list
that appears, tap the coordinate system you want to use.
Depending on your choice, ProMark3 may then ask you
additional information:
- If you select Lat/Lon, you are then asked to select the
display format (DEG/MIN.MMM, DEG/MIN/SEC.SS,
etc.)
- If you select any system other than Lat/Lon or UTM,
you are asked to choose a scaling factor for displaying
position coordinates: 1 meter, 10 meters or 100
meters. If you choose 1 meter, a northing coordinate
will be displayed as, for example, 249143N. If you
chose the 10-meter factor, the same coordinate will be
displayed as 24914N. And if you select the 100-meter
factor, the coordinate will be displayed as 2491N.
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- For some systems, you are asked to supply information
on grid zones or types
- For the User Grid, you are asked to supply a projection
type (Transverse Mercator, Lambert Conic, Stereographic, Oblique Mercator or Polyconic), coordinates
of origin, scale factor, unit to meters conversion and
false Easting and Northing at origin
Notes on Coordinate Systems:
- The ProMark3 always uses the WGS 84 coordinates to
locate the features and waypoints on the Map screen, even
if you select some other coordinate system/datum.
- The coordinate systems and datums used to display anything on the Map screen are only for display. When you
select some other coordinate system/datum, only the numbers of the coordinates of a feature/waypoint are changed.
The map screen is not changed in appearance.
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Map Datum
This option allows you to define a primary map datum,
and also a secondary map datum if you need one.
A map datum is a geographic reference that ProMark3 will
refer to to calculate the coordinates of your position.
ProMark3 holds more than 70 different map datums in its
memory.
After selecting the Map Datum option from the Setup
menu, tap the map datum that applies to your country and
working area.
To enter a user map datum, select the term “USER” in the
list of datums arranged in alphabetical order. Then, for
more information on how to enter a user map datum, refer
to the appendix at the end of this manual (page 194).

Time Format
This option allows you to select the time format you want
to use in ProMark3. You can choose from three different
time formats: Local 24Hrs, Local AM/PM or UTC.
After selecting the Time Format option from the Setup
menu, just tap the time format you want to use.
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Units
This option allows you to select the units of measurement
that will be used when displaying navigational data or features being logged.
All sets of units are formatted as follows: long distance unit/
short distance unit/speed unit/area unit. You can select from 5
different sets of units.
You can also create your own set of units by selecting
Advanced at the end of the list. You are then prompted to
specify the unit you wish to use for each type of possible
measure, i.e. Distance, Speed, Elevation, Bearing and
Area.
After selecting the Units option from the Setup menu, tap
the set of units you wish to use. If you have selected
Advanced, a new list appears prompting you to choose a
unit for each type of measure. Tap the first measure in the
list and then tap the desired unit. This takes you back to
the former screen where you can select the second measure, etc. When all units are defined, press ESC to come
back to the Setup menu.

Alarms
All of the Alarm options are set in the same way. The
instructions below apply to all of the Alarm settings. When
the beeper is turned on for alarms (see Beeper option) an
audible beep will be sounded for the alarm. A visual alert
is displayed for the alarm whether the beeper is turned on
or off.
Setting the Arrival Alarm: The arrival alarm alerts you that
you have arrived at the destination of your GOTO route or
to the destination of any leg in a route you are navigating
on.
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This option allows you to set how close you must come to
the destination before the alarm begins to sound.
After the alarm sounds, you can reset the arrival alarm to a
shorter distance, but this shorter distance will apply to the
next target and not to the current one. If you want the
alarm to sound again when you come within a shorter distance to the current target, first select another target destination and then reselect the original target.
Setting the PDOP Alarm: This turns on or off the alarm
that can sound whenever ProMark3 has lost its ability to
compute accurate position fixes due to poor geometry of
the GPS constellation. Generally, PDOP values less than or
equal to “5” are indicative of good operating conditions.
So it is a good idea to set this alarm to “5.” To turn off the
PDOP alarm, enter “00.”
Note: Apart from the Arrival and PDOP alarms, ProMark3
will generate a warning message on the screen in each of
the following two cases:
- “Low Memory.” This message will appear when the
receiver is running out of memory. If raw data is being
collected with the Surveying function or a GIS job is
being logged, then the occurrence of this message will
automatically stop data logging. You will however be
allowed to enter the attribute values of the current GIS
feature before the job is closed.
- “Out of Memory.” This message will appear when the
memory is full. The occurrence of this message will
immediately end raw data collection or close the currently open GIS job and you will not be able to log anything until you free some space in memory.
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North Reference
This option allows you to define the type of North reference you want ProMark3 to use. This can be True North,
Magnetic North, Military True North or Military Magnetic
North.
After selecting the North Reference option from the Setup
menu, tap the desired North Reference from the displayed
list.

Beeper
This option allows you to enable (On) or disable (Off) the
beeper.
After selecting the Beeper option from the Setup menu,
tap the desired option.

Reset Trip
If you tap this option, a warning message is displayed asking you to confirm your choice. To reset the trip odometer,
tap the Yes button.
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Clear Memory
This option allows you to clear one of the following data
sets from ProMark3’s memory:
- Track history: Will clear the track shown on the Map
screen.
- Wpts/Routes: Will clear all waypoints and routes from
memory.
- Routes: Will clear all routes from memory.
- Reset default: Will reset the receiver by restoring all factory defaults.
- All: Will clear all memory.
(Clear All does not delete files but only waypoints,
routes, track and user settings (language), as opposed
to Delete All in File Manager which deletes all listed files
but does not impact waypoints, track and routes; see
page 145.)
After selecting the Clear Memory option from the Setup
menu, tap the desired choice. ProMark3 will ask you to
confirm your choice. If you have selected All, ProMark3
will then exit from the current application to return to the
ProMark3 workspace screen. It will then automatically relaunch the same application for which re-initialization will
be required (user language).
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Simulate
This option allows you to set the simulator. It shows you how
ProMark3 uses its various functions based on a simulated
journey. The simulator is useful for learning or demonstrating
ProMark3’s GPS functions when indoors and there is no GPS
reception. When the simulator is on, ProMark3 quits normal
operation to operate in the simulator mode. You can choose
one of the following three options when you access the Simulate option:
- Off: Will turn the simulator off. ProMark3 will return to
normal operation
- Auto: Will turn the simulator on. A predefined heading
and speed rate will be used.
- User: Will turn the simulator on. A user-defined heading and speed rate will be used.
After selecting the Simulate option from the Setup menu,
just tap the desired choice.
If you have selected User, ProMark3 will then ask you to
enter heading and speed data.

Language
This option allows you to select the language that
ProMark3 will use to display text.
TIP: If you accidentally set the language to one you cannot
read and want to get back to the Language Select screen,
follow these instructions. Press MENU. Tap the fifth item
in the list and then tap the last item in the new list. You
are back at the Language Select screen.
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Customize
The Map screen must be in
Position mode if you wish
to customize data fields. If
the Map screen is in cursor
mode (cursor is a crosshair), press ESC to return
to the Position mode.

Available data:
BEARING
DISTANCE
SPEED
HEADING
VMG (Velocity made good)
CTS (Course to steer)
ETA (Estimated time of
arrival)
ETE (Estimated time
enroute
XTE (Crosstrack error)
Turn
Elevation
Time
Date
EPE (Estimated Positional
Error)
Avg. Speed (Average
speed)
Max Speed
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Except for the Satellite Status screen, all navigation screens
can be customized through the following procedure:
• Press NAV repeatedly until the desired navigation screen
is displayed
• Press MENU
• Tap Customize. Additionally for the Map screen, tap Customize Fields.
• On the Navigation screen now shown in edit mode, highlight the data field to be changed using the left/right arrow
and press ENTER
• Choose the data in the list that you wish now to display in
this field. Press ENTER. Data change in the field is immediate.
• Resume this procedure for all the fields that need to be
changed on this screen and on the other navigation
screens.
If you select Customize when the Map screen is displayed, another option an additional menu is displayed showing two option:
- Customize Fields: This option is described above
- Street info: If you select this option, the bottom of the Map
screen will display the name of the street you are currently
walking or driving along. To re-activate the first option,
press MENU, tap Customize and then Two Data Fields.

About...
The About... screen displays the current status of your
ProMark3.
Using the About... screen you can see the serial number of the
receiver, the version of software, the version and memory size
of the basemap and the memory space percentage occupied
by data & maps, routes and waypoints.

Exit
This option allows you to quit the Surveying or Mobile Mapping application that is currently running and return to the
ProMark3 workspace screen.
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8. Power Management
ProMark3 comes with a removable/rechargeable battery,
which provides enough energy for a full working day –provided
you start your day with a fully charged battery. In order to ensure a longer battery life, use the external power whenever
possible. When used, the external power source also automatically recharges the internal battery.

Power Saving Modes
The built-in advanced power saving features also help to optimize power consumption while the system is idle. The
ProMark3 system has two power saving modes when the internal battery is used:
1. User Idle state: A state in which you are using the
ProMark3 but not actively interacting with it. For example,
you may be only looking at the display and not interacting
with the system.
2. System Idle state: A state in which you are not directly
using the ProMark3 but processes in the unit are still
active.
You can configure the ProMark3 to automatically enter each
state when it has been idle for a specified time.
To change the idle times, from the ProMark3 workspace
screen, double-tap the Settings icon and then the Power icon.
Then make the necessary changes on the Schemes tab (see opposite.)
We recommend that you keep the default setting (“Never”) for
the last field.
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Backlight Control
To adjust or turn on and off the backlights manually, first exit
from the Surveying or Mobile Mapping function if you are
working with one of these functions. Then from the ProMark3
workspace screen, double-tap the Settings icon. A list of functions is now displayed on the screen. Double-tap Backlight Control.
In the window that opens (see figure opposite), you can do the
following:
- Adjust separately the brightness for the keypad and the
brightness for the screen by dragging horizontally the corresponding cursors on the screen
- Adjust the screen contrast by moving the corresponding
cursor.
- Tap the Backlight OFF button to turn off the backlight
- Tap the Backlight ON button to turn on the backlight
The backlight can also be turned off automatically after a
user-set time delay. This delay will add up to the delay required before ProMark3 enters the User Idle state (see
page 164). For example, if the ProMark3 switches to the User
Idle state after 2 minutes of inactivity and the Backlight Off
time delay is 15 seconds, then the backlights will turn off after 2 minutes and 15 seconds of inactivity.
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To enable and set the Backlight-Off time delay, first exit from
the Surveying or Mobile Mapping function if you are working
with one of these functions. Then from the ProMark3 workspace screen, double-tap the Settings icon and then the Display icon. On the Backlight tab (see opposite):
- Check each of the two boxes on the left and then choose a
Backlight-Off time delay for each case of power source
(battery or external)
- Tap OK to close the dialog box.
After the backlights have been automatically turned off
through this process, it is very easy to turn them back on: you
just need to press a key or touch the screen.

Checking Battery Status
From the ProMark3 workspace screen, double-tap the Settings
icon and then the Power icon. Tap the Battery tab. This tab provides a visual indication of the the battery level (see opposite).
Note that it takes a few minutes after you have turned on the
unit before this tab indicates the accurate status of the battery.
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LED Indicators
Power LED (Green)
Off
Solid Green

Indicates:
Device Switched Off
Power On

Charge LED (Amber)
Charge
Power

Off
Solid Amber
Blinking Amber

Indicates:
Not charging
Battery is fully charged
Battery is charging

The charge LED will give charging information only if the receiver is on.

Turning Off ProMark3
Press the red key until the Shutdown window appears. Tap OK
to confirm that you want to turn off the unit. As a result, the
unit instantly shuts down.
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9. Diagnostics & Upgrade Tools
This chapter focuses on the different ProMark3-embedded
tools that allow you to test the operation of your ProMark3.

Testing ProMark3’s Internal Peripherals
Use the Tests utility.
This utility can be found in the Utilities folder. To run this utility from the ProMark3 workspace screen, double-tap the Utilities icon and then the Tests icon.
The Tests utility allows you to test various elements in the unit,
namely USB, keypad, LCD, touch screen, speaker, serial port,
Bluetooth and SD card.
After launching Tests, tap Start. All the tests are then run in
succession. You can skip the test in progress by tapping Skip,
or all the remaining tests by tapping Skip All.
USB test: Plug a Mass Storage USB device, wait about 10
seconds and then tap OK.
If the test is successful, the unit will switch to the next test.
If the test fails, a Failed button will appear at the bottom of the
screen, next to the OK button. You can either retry the test by
tapping OK, or acknowledge that the test failed by tapping the
Failed button. The unit will then continue with the tests.
Keypad test: Successively press the key corresponding to the
white spot shown on the screen. If the key is pressed successfully, the spot turns green and a new white spot appears on another location on the screen prompting you to press the
corresponding key, etc. Tap OK at the end of the test.
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LCD test: Consists of displaying different colors and shapes
with different levels of brightness and contrast. There is no
user action required. This test can be skipped by pressing the
ESC key.
Stylus test: Follows automatically. Takes place as described
in Calibrating the Screen on page 25. You can skip that test
by pressing the ESC key.
Speaker test: Tap Passed after the speaker has correctly emitted three different sounds with increasing volume. The test
will be repeated indiefinitely until you tap Passed (or Failed if
the test failed).

Serial Port test: You first need to connect a female plug on the
ProMark3 I/O module’s RS232 port on which pins 2 and 3
have been shorted. Then tap OK to start the test.

SD card test: You first need to insert an SD card in the unit
and then tap OK.

At the end of the tests, the initial dialog box reappears on
which you can see the tests that passed and those that failed.
Note that Bluetooth is tested through an internal routine (see
BT ADDR:... line).
Tap OK to close the Tests dialog box.
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Testing GPS Section
Use GPS Status.
This utility can be found in the Utilities folder. To run this utility from the ProMark3 workspace screen, double-tap the Utilities icon and then the GPS Status icon.
GPS Status allows you to quickly check the current status of
the GPS constellation after initializing the GPS section of the
ProMark3 using the GPS Init utility (see GPS Init on
page 176).
GPS Status gives a more detailed report of the GPS reception
conditions than the Satellite Status screen does. (This screen
can be displayed from within the Surveying or Mobile Mapping
applications by pressing the NAV key.)
GPS Satus can also be used to log and playback NMEA data.

Signal Quality/Navigation Window (Sig/Nav)
This window allows you to monitor Signal/Noise ratios for received satellites. This information is shown in graphical form.
The signal quality window will grow or shrink to accommodate
the number of satellites in view. The Position pane provides
the coordinates of the current GPS position, including elevation. The “GPS Mode” bar displays the type of position being
calculated by the GPS receiver.
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There are three groups of GPS modes that can be displayed:
NOFIX, 2D/3D, and differential modes.

Azimuth and Elevation Graph (Azmth/Elvn)
This graph shows all the satellites currently in view. Each satellite is identified by its pseudo-random number (PRN), its azimuth and elevation angles.
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Panel Window (Panel)
This window displays the following parameters relevant to the
unit: speed, altitude, heading and vertical speed.

Statistics Window (Stats)
This window provides the averaged coordinates of the computed position and shows the accuracy figures corresponding to
the GPS receiver used in static mode. The Dilution of Precision (DOP) values are also displayed.
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Logging NMEA Data
- In the menu bar, tap Log and then Start.
- Select the folder where you want the data file to be stored.
This can only be on the SD card!
- Name the file using the on-screen keyboard. To be able to
see the Name field, tap and hold the keyboard from its title
bar and drag it upward.
- Tap OK located on top of the dialog box. Data logging
starts immediately. The “Log:<current file size>” message
appears in the status area at the bottom of the screen.
- To stop data logging, tap Log and then Stop. Data logging
stops immediately.
Example of logged data:
Log Start: 2005/10/12 -- 01:56:56
$GPGSV,4,1,14,08,27,062,44,15,11,312,36,09,22,252,41,10,32,181,45*71
$GPGSV,4,2,14,18,21,316,44,27,01,068,28,29,84,045,48,07,06,126,37*7E
$GPGSV,4,3,14,26,76,323,48,19,01,015,36,28,50,075,48,21,12,280,43*74
$GPGSV,4,4,14,37,32,151,40,35,16,241,38*75
$GPGGA,085656.00,4717.93754,N,00130.54139,W,2,09,1.0,036.93,M,49.6,M,,*48

- Insert the SD card in your local SD Card reader to transfer
the log file for further use.
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ProMark3 Serial Number & Versions
Use Thales System Info.
This module can be found in the Settings folder. To run this
module from the ProMark3 workspace screen, double-tap the
Settings icon and then the Thales System Info icon.
This module provides the following information on the hardware, software and GPS section currently installed in your
ProMark3:
• Hardware:
- Serial Number
- BT MAC Address
• Software:
- OS F/W Version
- EBoot Version
• GPS:
- GPS F/W Version
- GPSData Server.

Upgrading ProMark3 Software & Firmware
Use AutoLoader.
This utility can be found in the Utilities folder.
When Magellan releases new ProMark3 software or firmware
(in the form of a single txt file), you will have to:
- Copy the txt file to an SD card
- Insert that SD card into your ProMark3
- Launch the AutoLoader utility: from the ProMark3 workspace screen, double-tap the Utilities icon and then the
AutoLoader icon
- Select the TXT file you need to load and then let the AutoLoader utility complete the upgrade for you.
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ProMark3 Reset Procedures
Hardware Reset
Clears the user settings and shuts down the unit.
Use the following key combination to hardware-reset the
ProMark3 unit:
ESC+ENTER+Red Power key.

Software Reset
Re-boots the unit (start-up screen).
Use the following key combination to software-reset the
ProMark3 unit:
ESC+ENTER+IN
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10.Utilities & Settings
This chapter lists all the utilities and setting modules embedded in the ProMark3 unit. It gives details for all those utilities
and setting modules that are not addressed elsewhere in the
present manual. For all others, cross-references are provided.

Utilities
To run a utility from the ProMark3 workspace screen doubletap the Utilities icon and then double-tap the icon of the utility
you want to run. You can only run one utility at a time.

GPS Init
This utility is in fact used when first using your ProMark3. Refer to Initializing GPS on page 27 in this manual or to the
ProMark3 Getting Started Guide.

GPS Reset
This utility allows you to re-apply the default settings to the
GPS section of the ProMark3. When you tap Cold Reset,
ProMark3 clears such data as almanac and iono data, etc.
used by the GPS section.
You usually need tu run a cold reset after installing new firmware or software in your ProMark3.

GPS Status
Refer to Testing GPS Section on page 170.

GPS Config
For future developments.
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Backup
This utility allows you to save the unit’s current configuration
data to an SD Card. Note that user data files are NOT included
in configuration data.
To create a backup file, first insert an SD card into the unit,
then name the backup file. Tap Backup when you are ready to
create the backup file. When the backup is complete, the
name of the backup file appears in the list box.
Using Backup, you can also restore or delete any backup file
saved on the inserted SD Card.

SNR Test & Burning Test
Test utilities used in manufacturing only. Not user test tools.

AutoLoader
Refer to Upgrading ProMark3 Software & Firmware on
page 174.

Tests
Refer to Testing ProMark3’s Internal Peripherals on page 168.

Chinese
A utility intended for future developments in Chinese language.

SNProg
Test utility used in manufacturing only. Not a user test tool.

DGPS Config
Refer to DGPS Real-Time Configuration on page 28 and Implementing Real-Time DGPS on page 182.

177

Settings
To run a setting module from the ProMark3 workspace screen,
double-tap the Settings icon and then double-tap the icon you
want to run. You can only run one setting module at a time.

Backlight control
See Backlight Control on page 165.

Bluetooth Manager
The ProMark3 is equipped with built-in Bluetooth technology
that allows short-range connections to other Bluetooth-enabled devices such as the MobileMapper Beacon.
Use theBluetooth Manager to find, configure and establish
connections to other Bluetooth devices. To start the Bluetooth
Manager:
- Double-tap the Settings icon
- Double-tap the Bluetooth Manager icon
- Tap the ON button on Bluetooth Manager. The ProMark3
starts to search for other available Bluetooth devices that
are within range. The detected devices are then listed.
- To preserve battery power, we recommend that you enable
(turn on) Bluetooth only when using it: Tap the OFF button
on Bluetooth Manager to disable Bluetooth.
For more information on Bluetooth when used to connect
ProMark3 to a MobileMapper beacon, refer to Using MobileMapper Beacon on page 184.

178

Date/Time
This module allows you to set the date, time and time zone.
The time zone you choose in this module impacts the local
time displayed in the Surveying and Mobile Mapping applications. This module also allows you to ask for automatic clock
adjustment for daylight saving.
Changing the time in this window also updates the time running in the GPS Init utility (see page 176). So it’s a good idea
to set this window before running the GPS Init utility.
When the GPS section of the receiver has been initialized, the
time displayed in this window comes under GPS control which
means the time field provides the GPS time. This usually happens about 40 seconds after initialization is effective. From
this time, you should not change the time in this window.

Display
This module is used to:
• Choose the screen background
• Enable and set two Backlight-Off time delays that will be
activated after the ProMark3 switches to the User Idle
state (refer to Backlight Control on page 165).

Keyboard
This module allows you to refine the keyboard settings (repeat
delay and repeat rate) for optimum use.
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Owner
This module is used to identify the unit using the following information about the user: name, company, address, work
phone and home phone. To be able to see all the fields in this
dialog box, you will have to tap and hold the keyboard from its
title bar and drag it upward or downward.

Power
Refer to Power Management on page 164.

Regional Settings
This module is used to perform various local settings such as
number, currency, time & date formats. Default settings can
be obtained in one operation by selecting your language/country on the Region tab.

Stylus
As explained on the screen, the first tab allows you to set and
test your double-tap actions.
The second tab allows you to recalibrate the screen as explained in Calibrating the Screen on page 25.
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System
This three-tab window gives information on the internal components of the ProMark3 system.

Thales System Info
Refer to ProMark3 Serial Number & Versions on page 174.

Volume & Sounds
This module allows you to make volume and sound settings.
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11.Implementing Real-Time DGPS
The real-time DGPS functionality is needed in your ProMark3
when your applications require that the unit deliver submeter
positions while you are working in the field.
There are three different ways of providing ProMark3 with the
differential correction data needed for real-time DGPS:
• Using SBAS (Satellite-Based Augmentation System).
SBAS encompasses WAAS in the North American continent and EGNOS in Europe.
• Using Magellan’ MobileMapper beacon (a IALA/US Coast
Guard-compatible MF receiver)
• Using another RTCM source.
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Using SBAS
This is the easiest way of implementing real-time DGPS in
ProMark3.
As the correction data broadcast by SBAS uses the same
transmission channel as GPS, you don’t need any additional
equiment or cable. Receiving correction data will only require
one GPS reception channel in ProMark3. The allocation of
this reception channel will be managed internally so you won’t
have anything special to do except for the following:
• On the ProMark3 workspace screen, double-tap Utilities
and then DGPS Config.
• On the Mode tab, check SBAS by tapping on the button
next to SBAS.
• Tap OK. A message is displayed confirming that SBAS is
used as real-time DGPS source.
• Tap OK again. Close the Utilities folder and then run the
Surveying or Mobile Mapping application.
• Press the NAV key until the Position screen #1 is displayed. On this screen (see page 130), if you are not moving, you will notice that the “WAAS Average” indication is
displayed in the middle of the screen, meaning that the
ProMark3 now delivers DGPS position fixes.
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Using MobileMapper Beacon
Magellan’s MobileMapper Beacon can be used to provide
ProMark3 with real-time DGPS correction data from any beacon networks operated worldwide.
The connection between these two units can be achieved in
two different ways:
• Via Bluetooth
• Or via a serial cable using the RS232 protocol.

Via Bluetooth
Using ProMark3’s DGPS Configuration and Bluetooth Manager utilities, tuning the beacon receiver and monitoring its performance through wireless communication is a simple
process.
1. Establishing Communication Between the Two Units
• Power on MobileMapper Beacon and make sure your
ProMark3 device is within range. (The distance between
both units should be less than 10 meters.)
• On the ProMark3 workspace screen, double-tap Settings
and then Bluetooth Manager. Tap ON and wait for it to
detect the MobileMapper Beacon device.
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• Tap the plus sign box next to the beacon device name:

• Double-tap “Bluetooth Serial Port” to configure this port.
• Freely choose one of the listed ports (“COM3” for example):

• Tap OK.
• Tap OK in the Bluetooth Manager window.
• Close the Settings window (tap

)
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• Double-tap the Utilities icon and then the DGPS Config icon
• Tap Beacon and then tap the Open Port button
• In the list attached to the Port field, select the same port
as the one you chose earlier in the Bluetooth Manager window. Keep the default settings for the other fields.

• If you tap the Test button, a message will appear informing
you that the port is now available for read/write operations.
Tap OK to close this message.
• Tap OK in the Open Port window to open the port and to
return to the DGPS configuration window. Note that the
Open Port button has been renamed “Close Port”.
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2. Tuning the MobileMapper Beacon Receiver
• Still in the DGPS Configuration window, select the Tune
pane
• Choose one of the following options to tune the MobileMapper Beacon receiver:
- Tune Automatically: Automatic method (default choice).
- Tune by Frequency: Manual method. You are supposed
to know the reception frequency (range: 283.5 to
325.0 kHz in 0.5-kHz steps) and the MSK rate (100
or 200 bits per second) used by the reference station
you wish to use.
- Tune By Site: Manual method. You have to specify the
region and country where the reference station is
located. Then select the site name of this reference
station in the Beacon field.
• Tap the Tune button. If you tapped Tune Automatically, the
MobileMapper Beacon will automatically search for the
best signal, from a nearby reference station. Whatever
your tuning choice, after a while a “Beacon Tuned Successfully” message is returned. Tap OK to close the message
window.
• After the Beacon has been tuned, you can check the current tuning settings, Locked status (Yes/No), Signal
Strength in dBµV and Signal to Noise Ratio in dB.
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To read this information, you just need to select the Status
pane in the DGPS Configuration window:

• Finally, tap OK on top of the DGPS Configuration window
for all the settings to take effect. A new message appears
confirming the acquisition of RTCM data via the selected
port.
• Tap OK to close this message window.
• Tap OK to close the DGPS configuration window. Your
ProMark3 will now operate in real-time DGPS mode. After
launching the Surveying or Mobile Mapping function,
press the NAV key until the Position screen #1 is displayed. On this screen (see page 130), you will notice that
the “DGPS” indication is displayed in the middle of the
screen, meaning that the ProMark3 now delivers DGPS
position fixes.
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Via a Serial Link
1. Establishing Communication Between the Two Units
- Clip the I/O module to the ProMark3
- Use the data cable provided with the MobileMapper Beacon to connect this unit to the ProMark3 RS232 Port
(COM1). Port COM1 is located on the I/O module.
- Turn on the two units (ProMark3 and Beacon). When you
turn on the ProMark3, a message is displayed indicating
that an RTCM source is used on COM1: (but in fact the
port is not open yet for use). Tap OK to close the message
window and then follow the instructions below.
• On the ProMark3 workspace screen, double-tap the Utilities icon and then the DGPS Config icon
• On the Mode tab, tap Beacon
• Unless already done, select “COM1:” in the Port field and
then tap the Open Port button
• Unless already done, set the COM1 port as follows:
- Baud: 4800
- Parity: None
- Data: 8
- Stop Bits: 1
• Tap OK to close this window and return to the DGPS Configuration window.
2. Tuning the MobileMapper Beacon Receiver
Same as via Bluetooth. See page 187.
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Using Another RTCM Source
You can use another equipment used as the RTCM source. In
this case, see the manufacturer’s instructions to know how to
connect this equipment to the ProMark3. On ProMark3 side,
you just need to:
- Run the DGPS Config utility
- On the Mode tab, tap Other RTCM Source
- Then tap Open Port, select the port used, make the necessary settings and tap OK.
- Tap OK to close the DGPS Configuration window. A message will tell you that the RTCM source is now used in
ProMark3.
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12.Appendices
Main Alarm Screens
Alarm message

Alarm Acknowledge:
Tap anywhere on the
screen outside of the alarm
window to acknowledge
(erase) the alarm message.
The “Not enough satellites...” and “No external
antenna...” messages will
also automatically disappear when the condition
that triggered the message
also disappears.

Description & Action Required
(Surveying only)
You are trying to start data collection with no external antenna connected to the unit. Please connect
the external antenna using the appropriate cable
and resume data collection.
The internal battery is low and the unit will very
shortly be unable to function properly. Please
acknowledge the alarm, quit the current application, turn off the unit and replace the battery before
doing anything else.
The internal memory or SD card you are using for
data collection is almost full. Do one of the following: 1) If possible, free some memory space using
the File Manager command, 2) Switch to the other
possible medium using the Setup>Storage command or 3) Replace the SD card if you work exclusively with SD cards.
You were using the AC adapter as the power
source for the unit and you have just unplugged it.
The unit is now powered from its internal battery.
Just acknowledge the alarm.
If you are not collecting data, the unit warns you
that it would be unable to collect data at your current location due to poor GPS reception conditions:
Move to a better location.
If a survey is in progress (Stop & Go or Kinematic
without initialization or –less likely– Static), the unit
warns you that it has stopped collecting data until
the reception conditions improve.
You are performing a stop-and-go or kinematic survey that you initialized with the initializer bar or at a
known point. Poor reception conditions have triggered this message. Whether these conditions are
intermittent or persistent, you must now acknowledge this message and resume all or part of the
survey (see Re-Initialization on page 75).
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File Naming Conventions
Survey Data Collection
Any file created while collecting survey datais named according to the following conventions:

R2050A05.257
Day number when file was open
Year (last 2 figures only)
Session ID
Receiver ID
File Prefix

The session ID increments A-Z, which provides up to 26
unique session IDs for any given day number. If more than 26
files are collected in one day, the first digit of the year is used
as part of the session ID. The following file list illustrates the
session ID incrementing scheme:
R2050A05.257 ... R2050Z05.257
R2050AA5.257 ... R2050ZA5.257
R2050AB5.257 ... R2050ZB5.257, etc.
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GIS Post-Processing
Suppose you have created a new job named “JOB1.MMJ.”
You selected the post-processing job mode in ProMark3 so
that it records GPS measurement files in addition to
JOB1.MMJ. The table below illustrates how these files will appear at various stages of the differential correction process:
Rover file seen on receiver

JOB1.MMJ

Rover file seen on MobileMapper Transfer’s left
window, before download

JOB1.MMJ

Rover file seen on MobileMapper Transfer’s right
JOB1.MMJ
window, after download
Rover files seen with Windows Explorer, after
download

JOB1.MMJ, JOB1.B00,
JOB1.D00 and JOB1.E00

Rover file seen on MobileMapper Office’s DifferJOB1
ential Correction window

Suppose you have logged a reference station file on ProMark3.
The table below illustrates how the resulting files will appear
at various stages of the differential correction process:
R0001a06.014 (for 1st file logged
at point 0001 on the 14th day of
2006)
0001a06.014 (for the first file
Reference file seen on MobileMapper Transrecorded at reference station site
fer’s left window, before download
ID 0001 on the 14th day of 2006
Reference file seen on MobileMapper Trans- b0001a06.14, d0001a06.14,
fer’s right window, after download
e0001a06.14 and w0001a06.14
Reference files seen with Windows Explorer, b0001a06.14, d0001a06.14,
after download
e0001a06.14 and w0001a06.14
Reference file seen on MobileMapper
b0001a06.14
Office’s Differential Correction window
Reference file seen on receiver

The rover files with a B, D, E or W in the extension represent
files with different GPS measurements all related to the original rover file. MobileMapper Office handles the information
in these files automatically. But if you archive your files, you
should include them in the archived directories.
The reference files that start with B, D, E or W are similarly
handled automatically by MobileMapper Office but should be
archived together with the rover files.
Reference files recorded by non-ProMark3 receivers may have
other naming conventions.
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Defining a User Map Datum
The receiver software
allows you to define the
full set of 9 parameters
defining a map datum.
After pressing MENU and
selecting Setup>Map
Datum>Primary/Secondary and “USER” in the
prompted list, you now
have access to two different screens on which these
9 parameters are presented:
1st screen:
Delta A (meters)
Delta F (X 10,000)
Delta X (meters)
Delta Y (meters)
Delta Z (meters).
2nd screen (select Next>
at the bottom of the 1st
screen to access this
screen):
Rotation X (sec)
Rotation Y (sec)
Rotation Z (sec)
Scale factor (ppm).

Whether you are in the office using MobileMapper Office, or
in the field working with your receiver, the system lets you create the user map datum you need.
However you will not use the same methods in the receiver
and in MobileMaper Office to define the semi-major axis and
flattening for your user datum.
In MobileMapper Office, you will use the conventional way of
defining a user datum, i.e. by entering the semi-major axis (a),
the inverse flattening (1/f) and the other 7 parameters.
The method used in the receiver is different as it is based on
the use of parameters ∆a (Delta A)and ∆f (Delta F) –known as
the Molodensky parameters– instead of a and 1/f. The other 7
seven parameters are exactly the same as those in MobileMapper Office.
∆a and ∆f are defined as follows:

∆a (m) = a(WGS 84) - a(Local Datum)
∆f = f(WGS 84) - f(Local Datum)
Note that the flattening (f), instead of the inverse flattening
(1/f), is used in the expression of ∆f. So we have:
1
∆f = --------------------------- –
1--( WGS84 )
f

1 ---------------------1--( Local )
f

Because the resulting ∆f is a very small quantity, it is multiplied by 10 000 to make it easier to handle. (The resulting
value is closer to 1.) It is this value that you have to enter in
the Delta F field on the handheld screen.
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Calculation example:
WGS 84
a
1/f

Local
Datum

6 378 137
6 378 388
298.257 223 563 297
Complete the fields below on
the receiver screen using the
values of ∆a and 10000x∆f, below, left):
Delta A (meters)


∆a
fWGS 84
fLocal
∆f
10 000 x ∆f

- 251 m
3.352 810 665 x 10-3
3.367 003 367 x 10-3
-- 0.014 192 702 x 10-3
- 0.141 927 02

Delta F (X10,000)

∆a and ∆f of Frequently Used Datums
Name

a

1/f

Da

Df x 10 000

Airy
Australian National
Bessel 1841
Bessel 1841 (Nambia)
Clarke 1866
Clarke 1880
Everest
Fischer 1960 (Mercury)
Fischer 1968
GRS 1967
GRS 1980
Helmert 1906
Hough
International
Krassovsky
Modified Airy
Modified Everest
Modified Fischer 1960
South American 1969
WGS 60
WGS 66
WGS 72
WGS 84

6377563.396
6378160.0
6377397.155
6377483.865
6378206.4
6378249.145
6377276.345
6378166.0
6378150.0
6378160.0
6378137.0
6378200.0
6378270.0
6378388.0
6378245.0
6377340.189
6377304.063
6378155.0
6378160.0
6378165.0
6378145.0
6378135.0
6378137.0

299.3249646
298.25
299.1528128
299.1528128
294.9786982
293.465
300.8017
298.3
298.3
298.247167427
298.257222101
298.3
297.0
297.0
298.3
299.3249646
300.8017
298.3
298.25
298.3
298.25
298.26
298.257223563

573.604
-23.0
739.845
653.135
-69.4
-112.145
860.655
-29.0
-13.0
-23.0
0.0
-63.0
-133.0
-251.0
-108.0
796.811
832.937
-18.0
-23.0
-28.0
-8.0
2.0
0.0

0.11960023
-0.00081204
0.10037483
0.10037483
-0.37264639
-0.54750714
0.28361368
0.00480795
0.00480795
-0.00113048
-0.00000016
0.00480795
-0.14192702
-0.14192702
0.00480795
0.11960023
0.28361368
0.00480795
-0.00081204
0.00480795
-0.00081204
0.0003121057
0.0
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Upload/Download Procedures (Summary)
Surveying
Download
Survey Data
Files
Survey Data
Files

Upload
Vector Background map
Control Points

From
ProMark3 (from SD card
or internal memory) (1)
SD Card (in local SD card
reader) (4)

To
Project folder using
Download utility
Project folder using
Download utility

To
ProMark3 (to SD card or
internal memory) (1)
ProMark3 ( to internal
memory only)

Using (2)

USB or RS232 link Page 79
Local SD card
reader

From
GNSS Solutions
GNSS Solutions

See

Using (2)
USB or RS232 link

Page 82

See
Page 84

USB or RS232 link Page 86

Mobile Mapping
Download
GIS data files

GIS data files

From

To

Job folder using
ProMark3 (from SD card
MobileMapper Transor internal memory) (1)
fer utility
Job folder using
SD Card (in local SD card
MobileMapper Transreader) (4)
fer utility

Using (2)

See

USB or RS232 link Page 111
Local SD card
reader

Upload

To

GIS job and
waypoint files
GIS job and
waypoint files
Vector Background map
Vector Background map (3)
Vector Background map (3)

ProMark3 (to SD card or
internal memory) (1)
SD card (in local SD card
reader) (5)
ProMark3 (to SD card or
internal memory) (1)
SD Card (in local SD card
reader) (5)

From

USB or
MobileMapper Office
RS232 link
Local SD card
MobileMapper Transfer
reader
USB or
MobileMapper Office
RS232 link
Local SD card
MobileMapper Office
reader

Using (2)

PC hard disk

MobileMapper Office

N/A

Page 113

See
Page 121
Page 122
Page 118
Page 118
Page 118

(1) Use MENU>Setup>Storage on ProMark3 to select the storage medium
used.
(2) From fastest to slowest data transfer method: 1) via Local SD card reader,
2) via USB, 3) via RS232.
(3) ProMark3 must be connected via USB or RS232 to allow MobileMapper
Office to generate the map specifically for use in ProMark3.
(4) SD card extracted from ProMark3 to be inserted in the local SD card
reader.
(5) SD card later inserted in the ProMark3 for use in the field.
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Ordering Information
NOTE: Magellan reserves the right to make changes to this list
without prior notice.
Item

Designation

Part
Number

I/O Module

980808

USB Cable

730396

AC Adapter/Charger

980783

External GNSS Antenna

110454

External Antenna Cable

702058

Vertical Antenna Extension

103717

Field Receiver Bracket

702065

HI Measurement Tape

111146

Field Bag

111132
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Item
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Designation

Part
Number

ProMark3 User Documentation & MobileMapper Office
Software

500900

Initializer Bar and Antenna
Adaptor

800954

GNSS Solutions CD

702081-01

Glossary
Attribute: A description item of a feature.
Attribute value: One of the possible values that can be ascribed to a
feature.
Base Station: See Reference Station.
B-File: A binary data file containing
GPS measurement data.
Carrier phase data: Phase angle measurements for the 1575 MHz radio wave carrying the GPS coded messages. Using carrier phase data
greatly improves GPS accuracy.
Datum: A mathematical definition of a surface from which coordinates of a given system are referenced.
D-File: A binary data file created by field collection software and
stored in the receiver.
DGPS: Differential Global Positioning System. Commonly used to refer to real-time differential correction techniques.
Differential Correction: The process of:
(1) calculating how much to adjust GPS measurements to reduce the
difference between a location's surveyed coordinates and the coordinates calculated by a GPS receiver that is kept stationary over that
point; and
(2) the application of these adjustments to the GPS measurements recorded by any number of receivers within a few hundred kilometers of
the "reference receiver."
Differential GPS: See DGPS.
E-File: A binary data file containing GPS ephemeris data.
Ephemeris Data: Information transmitted from a satellite which allows the GPS receiver to determine the satellite’s position in space.
Export: Converting MobileMapper data files to GIS Formats and writing them to any directory visible to the PC.
Feature: Any element located in the field that you wish to record for
further uploading into a GIS database for example. A feature can represent a real object (streetlight, park, electrical transformer, etc.) or
on the contrary, something invisible or impalpable (gas, noise level,
dose of fertilizer, etc.).
Each new feature that you log in the field can only be an “emanation”
or “offshoot” of one of the feature types described in the feature type
library associated with the job in progress. The logging procedure will
be different depending on the type of the feature you are logging.
To log a feature: Means to save the characteristics of a feature
into the receiver memory. The user is in charge of entering the
description of this feature whereas the receiver is responsible for
saving the GPS position(s) it has determined on this feature.
To describe a feature: Means to give each attribute of the feature
one of the prompted values for this feature.
Feature Library: A file containing all the feature types required for a
given job. (In fact we should say “Feature Type Library”.)
Feature Type: An item present in a feature library. Each feature type
is defined by a geometry type, a name, a certain number of possible
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attributes and the list of possible values for each attribute. There are
four different geometries in feature types: point, line, area and grid.
Field: Any area on the receiver screen dedicated to displaying the value of a parameter. Some fields are user-editable, some others are not.
Geographic Information System: A system of digital maps, data analysis software and a database of features, attributes and geographic locations.
GIS: See Geographic Information System.
Global Positioning System: A system of satellites providing worldwide
coverage for positioning information. Although installed and maintained by the United States, the broadcast signals are available to
anyone anywhere in the world.
GPS: See Global Positioning System
GPS satellite geometry: The satellite distribution at a given location.
measured by the PDOP index
GPS signal multipath: Occurs when the GPS signal arrives at the antenna by a path other than a straight line. Multipath signals make the
receiver think that a GPS satellite is farther away than it is and the
resultant position is inaccurate.
Job file: File containing a feature type library and a collection of features that grows as you log new features in the field with this job file
open. All the features in the job file necessarily “originate” from the
feature types present in the job file’s feature type library.
Nesting: This word is used to describe a feature that you are logging
whereas another feature is already being logged.
PDOP: Positional Dilution of Precision. An accuracy factor derived
from the geometry of the constellation of GPS satellites used to calculate a position. In general, the more widely distributed the satellites
are in the sky, the greater the accuracy. In general, PDOPs less than
10 are good.
Post-processing: Differential corrections applied to GPS positions in
a PC - after both rover and reference data are logged and downloaded.
Post-processing is slower but more accurate than real-time differential correction.
RTCM: Radio Technical Commission for Maritime Services. Commonly refers to a format of real-time DGPS format.
Reference Station: A stationary GPS receiver logging, or broadcasting,
data from a known point. The data is used for differential correction.
Reference Station is synonomous with Base Station.
RINEX: Receiver Independent Exchange Format. A “universal” GPS
measurement data format designed to allow compatibility b tween different brands of GPS receivers.
Shapefile: A set of GIS files invented by ESRI but published as an
open file standard readable by most GISs. A shapefile consists of a
map file (SHP), a file containg feature descriptions (DBF), a file relating the map locations with the feature description (SHX) and
sometimes a file containing coordinate system information (PRJ).
Waypoint: A pre-determined coordinate point to which a GPS receiver
can navigate. GPS receivers can also log waypoints in the field for lat-
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er navigation. GPS for GIS receiver have largely replaced waypoints
with point features.
W-File: A binary data file containing SBAS data.
WGS-84 coordinate system: World Geodetic System, 1984. The coordinate system is used by GPS receivers for computing their positions.
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Index
- sign 145

Symbols
# Sats 51, 64, 73
+ sign 145

Numerics
3D/2D 125

A
AC adapter 5, 21
Accuracy 124
Adaptor (antenna adaptor) 7
Alarm screens 191
Alarm, Arrival 157
Alarm, PDOP 158
Almanac 38
Alphabetical 137
Antenna Height 48, 59, 69
Area measurement 116
Attribute (feature attribute) 15
Autoloader 174
Automatic tuning 187
Averaging 131
Azimuth and elevation 171

B
Backlight 26
Backtrack 143
Backup utility 177
Bag (field bag) 6
Base station 12, 13
Basemap 150
Battery door 3, 21
Battery life 21
Bearing, offset 100
Beeper 159
Bluetooth 178, 184
Bluetooth Manager 178
Boundary survey 32
Bracket (field bracket) 6

C
Cable (antenna cable) 5
Calibrating the screen 25
Clear, memory 160
Closed-loop traverse 32, 33
Coast Guards 124
Collected data 31
Columns, grid feature 104
Compass 132, 133
Compass screen 128
Connect via cable 80

Control Point 49
Control points 86
Control points, fixed 86
Control points, non-fixed 86
Coordinate system 17
Coordinate systems 154
CSV 16
Current
Constellation 39
Cursor mode (map screen) 127
Custom map datum 17
Customize 162
Customize Fields 162

D
Data screen 133
Date and time 179
Datum 17
DC Power Input 4
Depart-Dest Line 152
Detail 151
Detail map 85, 150
DGPS 131
Direction, line or area feature offset 101
Display 179
DOP 39
Download utility 31, 80, 82
Download/upload procedures (summary)
196
DXF 16, 84

E
EGNOS 17, 182
Elapsed (time) 50, 73
Existing control point 32
Export data 123
Extension (vertical antenna extension) 6
External GNSS antenna 4, 5

F
Feature library 15
Feature Properties window 115
File Naming convention 51, 65, 73
Files, managing 146
Fixed column 83
Fixed-height GPS tripod 9

G
GIS features 2, 14
GNSS Solutions 2, 11, 13, 14, 18, 31,
38, 79
GNSS Solutions installation CD 7
GOTO 136, 140, 141
GPS Firmware version 174
GPS Status utility 170

GPS vector 36

Multi-leg 142

H

N

Handstrap 3
Hardware reset 175
Hardware version 174
Heading, grid feature 104
Height Type 49, 59, 69
HI 46
Holding the unit 14, 91
Horizontal Distance, offset 100

Naming conventions (GIS raw data files for
post-processing) 193
Naming conventions (survey raw data files)
192
Nav screens 153
Navigation screens 16, 17
Nearest To 137
NMEA 173
North reference 159
Number of tracked satellites 125

I
I/O module 3, 79, 111
IMI 85, 118, 119, 146
Import raw data from files 83
Indicator lights 167
Initialize 59, 69
Initializer bar 7
instrument height 46
Intervisible points 32, 34

J
Job content 114

K
Keyboard 179
Keypad test 168
Kinematic 13
Kinematic mode 19

L
Languages 161
Large Data screen 129
LED Indicators 167
Leg 144
Length measurement 116
Line-of-sight 35
Link (direct) 34
Lock status 187
Loop (strong) 34

M
Manual tuning 187
Map datum 156
Map datum (user) 194
Map screen 127
Mark 145, 146
Measurement tape 6
MIF 16, 84
Mini USB 4
Mission Planning 38, 40
MobileMapper Beacon 182, 184
MobileMapper Office 2, 15, 111
MobileMapper Transfer 16
Molodensky parameters 194

O
Observation
Plan 37
Times 38, 39
Observation Range 18, 40, 44, 50, 51,
64, 73
Occupation times 18
Offset 117
Ordering information 197
Orientation 151
OTF 20
Owner information 180

P
PDOP 18, 39, 51, 65, 73, 124, 125
Perimeter measurement 116
Pivot 11
Pivot point 37
Points in loop 34
Poor (availability) 39
Pos-Dest Line 152
Position screens 130
Post-processing mode 2, 15, 20
Primary Usage 152
ProMark3 CD (user documentation &
MobileMapper Office software) 7

Q
Quality (results) 38

R
Range Pole 9
Real-time corrections 3
Receiver ID 149
Recording Interval 14, 49, 59, 69
Reference points 86
Regional settings 180
Remain (time) 64
Reset Trip 159
Reset, cold 176
Reverse 144
Revisiting features 16

Road 132
Road screen 132
Routes 141, 148
Rows, grid feature 104
RS232 79, 80, 111, 118, 119, 121
RTCM 3, 124, 182, 190

S
Satellite
Availability 38, 39
Distribution 38
Geometry 39
Satellite Status screen 47, 58, 68, 135
SBAS 17, 124, 182, 183
Scale indicator 132
Scrolling button 3
SD card 1
SD card slot 4
SD card test 169
SD Card Utilities 163
Select Map 85
Serial port (COM1) 4
Serial Port test 169
Setup 149
Setup menu 145
Show Map Info 152
SHP 16, 84
Shutdown 167
Signal quality 170
Simulate 161
Simulator 161
Site ID 48, 51, 65, 73
Slant 49, 59, 69
Software reset 175
Software version 174
Solid-state memory 1
Sound 181
Spacing, grid feature 104
Speaker 3
Speaker test 169
Specifications 10
Speedometer screen 134
Static Mode 11
Static Survey screen 50
Statistics window 172
Stop-and-go mode 12, 19
Storage 149
Storage option 79, 111
Store on Hard Drive 119
Street info 162
Stylus 25, 180
Stylus test 169

Survey Mode 48, 58, 68
System Idle mode 164

T
Target on Map screen 108
Target points 86
Tests Utility 168
Time format 156
Total station 32, 33
Track history 160
Track Lines 152
Track Mode 151
Traverse legs 34
Traverse plan 33
Tribrach 8
Tripod 5, 8
Tripod (fixed-height) 5
Tune (MobileMapper Beacon) 187
Two Data Fields 162

U
Units 48, 59, 69, 157
Upload GIS job to ProMark3 16
Upload Positions to External Device 88
Upload to SD Card Reader 119
Upload/download procedures (summary)
196
USB 5, 79, 111
USB (mini-port) 5
USB driver installation 79, 111
USB flash drive 4
USB host port 4
USB test 168
User Idle mode 164
User map datum 156

V
Vertical 49, 59, 69
Vertical control points 33
Vertical Distance, offset 100

W
WAAS 3, 17
Waypoints 17, 86, 121, 122, 152
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Magellan
Survey Solutions Contact Information:
In USA +1 408 615 3970 ■ Fax +1 408 615 5200
Toll Free (Sales in USA/Canada) 1 800 922 2401
In South America +56 2 273 3214 ■ Fax +56 2 273 3187
Email surveysales@magellangps.com
In Singapore +65 6235 3678 ■ Fax +65 6235 4869
In China +86 10 6566 9866 ■ Fax +86 10 6566 0246
Email surveysalesapac@magellangps.com
In France +33 2 28 09 38 00 ■ Fax +33 2 28 09 39 39
In Germany +49 81 6564 7930 ■ Fax +49 81 6564 7950
In Russia +7 495 956 5400 ■ Fax +7 495 956 5360
In the Netherlands +31 78 61 57 988 ■ Fax +31 78 61 52 027
Email surveysalesemea@magellangps.com
www.pro.magellanGPS.com
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